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Hamilton’s Microlab STAR is the next generation pipetting workstation.  This User Manual is
designed to help you get the most out of your Microlab STAR.

You should read through the entire manual before beginning to operate your instrument.
This first chapter should be read with particular attention. It contains important information
about the use of the Microlab STAR and this manual.

���� �����������������

This manual is to help users operate the Microlab STAR correctly and safely.

To achieve that aim, Chapter 3 of the manual will describe the different components of the
Microlab STAR and how they work. Then, in succeeding chapters, we will describe what can
be done with each – the basic operations of aspirating and dispensing liquids. The manual
describes both the hardware and software of the Microlab STAR to the extent that a user
needs to know them in order to operate the instrument.

After introducing you to the various parts of the Microlab STAR, we show you step by step
how to perform typical operations using those components. Sample methods for typical
applications guide you through the programming. When you have worked through this
manual, you should be quite well able to operate the Microlab STAR.

�������� and ��	
� are included in this manual to emphasize important and critical
instructions. They are printed in italics in the left margin of the page, begin with the word
'Attention' accompanied by the '!' symbol, or the word ‘Note’, as appropriate.

This manual refers to User Software release 3.0 for the Microlab STAR.

���� �  ����������!���������"��������

A detailed software reference for the Microlab STAR is to be found in the online help of the
User Software.  This online help will answer any question you may have about details of the
Microlab STAR User Software.

The manner in which the Microlab STAR and its components are to be serviced is described
in the �����
���������
����
������
.  This manual will be made available to Hamilton-
authorized service technicians.

Whenever a manual amendment is issued, detailed instructions on amending the existing
manual will be provided.

��#� ����� � �$������������!���������"

The Microlab STAR is a robotic pipetting workstation, in other words, a sampler used for
pipetting liquid samples in an automated process suitable for medium to high throughput with
a high degree of flexibility in pharmaceutical, veterinary and genetics applications.

A user will typically wish to carry out low, medium, or high volume contamination-free
pipetting with disposable tips or with steel needles.

At the present time, the Microlab STAR is classified as a general laboratory instrument and is
not specifically validated as an �����	�� diagnostic device.
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��%� �&�������

The operator of the Microlab STAR must have attended an appropriate training course. The
procedures contained within this manual have been tested by the manufacturer and are
deemed to be fully functional. Any departure from the procedures given here could lead to
erroneous results or malfunction.

��'� �����(

The following section describes the main safety considerations, electrical and biological, in
operating this product, and the main hazards involved.

��'��� 
�������)��!�������

When using Microlab STAR, Good Laboratory Practices (GLP) should be observed.  Suitable
protective clothing, safety glasses and protective gloves should be worn.

During Microlab STAR operation, do not place hands in the way of moving parts or on the
working deck. Keep your head and hands away from the work surface of the Microlab STAR
when it is in operation – the pipetting arm and channels move fast and it is possible to
sustain an injury. In general, never lean over the Microlab STAR when working with it.

When working with samples, do not switch tubes around after they have been identified by
the barcode reader.  This could result in incorrect test data.

When working with samples which will be used in particularly sensitive tests, take into
account evaporation and condensation that may occur while the method is running.

Perform test runs i) with deionized water and ii) with the final liquids, prior to routine use.
Test for all the liquid classes you are going to use.

Liquid level detection needs to be explicitly tested when working with foaming liquids.

If sampling aggressive liquids, use filter tips.

During operation, the Microlab STAR should be shielded from direct sunlight and intense
artificial light.
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For repair or shipment, all mechanical parts must be put in their rest positions. A Microlab
STAR sent away for repair must also be decontaminated if it was in a laboratory environment
with infected or hazardous materials. The Microlab STAR must be repacked in the original
shipping crate and only by an authorized service technician. There should be no containers
or tips on the Microlab STAR during transportation.

Only original HAMILTON Microlab STAR-specific parts and tools may be used with the
Microlab STAR, e.g. carriers, racks, tips, steel needles, and waste containers. Commercially
available liquid containers, such as microtiter plates and tubes, may of course be used.

If working with contaminated samples, the user need not touch them. The Microlab STAR will
drop its used tips into a waste container that should be emptied as soon as it is full.

The Microlab STAR products conform to European norms as regards interference immunity.
However, if the Microlab STAR is subjected to electromagnetic RF fields, or if static electricity
is discharged directly onto the Microlab STAR, its Liquid Level Detection ability (see below)
may be negatively affected.  It is therefore recommended that the Microlab STAR be kept
away from other equipment that emits electromagnetic RF fields in the laboratory, and that
static electricity be minimized in its immediate environment.

��'��� ���!���!��������(�)��!�������

Before removing a mechanical or electrical component, the Microlab STAR must first be
switched off and disconnected from the main electricity supply and PC.

��'�#� �����*�� �)��!�������

If the Microlab STAR becomes contaminated with biohazardous material, it should be
cleaned in accordance with the maintenance procedures given in the section “Maintenance”
(3.7).  Observe and carry out the maintenance procedures given.  Failure to do so may
impair the reliability and correct functioning of the Microlab STAR.

If working with biohazardous samples, observe and carry out the maintenance procedures
paying particular regard to cleaning and decontamination. Wear gloves when handling the
pipetting arm and channels, the carriers, racks, and containers, and the tips and steel
needles. Avoid touching the discarded tips in the waste container. Any surfaces on which
liquid is spilled must be decontaminated.

��'�%� 	��&�����)��!�������

Guard against software viruses.  Use only manufacturer’s original installation CD-ROM sets
for the operating system, and the original HAMILTON software.

Only the HAMILTON User Software and the firmware protocol (CoCo/KuSt, cf�� �����
��
������
����
������
) may be used to control the Microlab STAR.
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HAMILTON Bonaduz AG, CH-7402 Bonaduz / Switzerland is the manufacturer of the
Microlab STAR.

The Microlab STAR is sold in accordance with the general conditions of sale of HAMILTON
Bonaduz AG.

HAMILTON warrants this product to be free of defects in material and workmanship for a
period of 12 months from the date of delivery, ex works Bonaduz.

HAMILTON or the authorised HAMILTON representative will repair or replace, at its option
and free of charge, any product that under proper and normal use proves to be defective
during the warranty period.

HAMILTON shall in no event be liable or responsible for any incidental or consequential
damage, either direct or contingent.

HAMILTON accessories and consumable products, e.g. carriers, racks, tips, steel needles,
and waste containers, are warranted to be free of defects in material and workmanship at the
time of delivery only.

The above warranty shall not apply if:

• the product has not been operated in accordance with the user manual;

• the product is not regularly and correctly maintained;

• the product is not maintained, repaired or modified by a HAMILTON-authorized
representative or user;

• parts other than original HAMILTON parts are used, except for liquid containers such as
microtiter plates and tubes;

• the product or parts thereof have been altered without written authorization from
HAMILTON Bonaduz AG;

• the product is not returned properly packed in the original HAMILTON packaging.

HAMILTON reserves the right to refuse to accept any product that has been used with
radioactive or microbiological substances, or any other material that may be deemed
hazardous to employees of HAMILTON.  Such a product has to be properly decontaminated
and marked.

HAMILTON endeavours to provide prompt and satisfactory service.
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Customer service will be provided in the first instance by the network of HAMILTON
representatives.  In the event of any problem experienced with your Microlab STAR, the first
recourse is your local HAMILTON representative.  For further problems requiring hardware or
software expertise, the Technical Support department at HAMILTON Bonaduz AG will be
available by phone, fax or e-mail to deal with your queries. Here is their address, phone, fax
and e-mail:

+����
&�������&���������,

HAMILTON Bonaduz AG
Technical Support

P.O. Box 26
CH-7402 Bonaduz / Switzerland

Phone +41 81 641 6060

Fax +41 81 641 6070

E-mail: itechsupport@ hamilton.ch

��
�����&�-���+��	&�����.����������,

HAMILTON Company
P.O. Box 10030

Reno, NV 89520-0012

USA

Toll Free: (800) 648-5950
Phone (775) 858-3000
Fax (775) 856-7259
E-mail: tech@hamiltoncompany.com



Microlab® STAR User Manual

Page 12 of 225                                                                                           610766/02

�� �����������)�&�����/

In this chapter the process of pipetting with the Microlab STAR is described. Pipetting means
transfer of small quantities of liquid from one container to another. A pipetting operation is
achieved by aspirating (drawing) liquid from a source container, then transferring and
dispensing (dropping) it into a target container.

���� ��������0��&��!������)�&�����/�)���!�&��

The Microlab STAR is based on the ���� ��&��!������&�&�����/ principle, comparable to the
functioning of hand pipettes. Air displacement means that the liquid is aspirated into and
dispensed from a disposable tip or needle by the movement of a plunger. Between the
plunger and the liquid surface is air.  No system liquid of any kind is involved in the Microlab
STAR.

��
���������
��
�
�	�.��
		����.������



The air displacement principle has the following advantages:

• Independent and modular design of pipetting heads for most flexible assay programming.

• CO-RE (compression-induced O-ring expansion) technology for the flexible coupling of

tips or needles to the pipetting channel.

• Tips or reusable needles of three sizes on the same head in the same run.



Microlab® STAR User Manual

610766/02                                                                                           Page 13 of 225

• The construction principle enables pressure-based liquid level detection and aspiration

monitoring.

• No contamination or dilution by system liquids.

• No drops due to moving tubes.

• No problems with corroded tubing, pumps, etc.

• Same commonly accepted pipetting principle as for hand pipettes.

���� �������&�����������0��&�����/

In this section we describe in detail the processes involved in a simple pipetting step.

������ ��&�)�!12�&

The first task for the Microlab STAR is to pick up a disposable tip or a reusable steel needle.
For tips, special carriers typically holding 5 tip racks of 96 tips are placed on the instrument
deck. Steel needles may be picked up directly from the wash station, or from a separate
needle rack, which typically is a tip rack on a tip rack carrier with needles instead of tips.

������ ��&�������

The first step within an aspiration and dispense cycle is to aspirate a variable amount of
blowout air, which is used at the end of the (last) dispense, to blow the liquid out of the tip.
This is done with the tips still in the air.

To start the aspiration of liquid, the tip must make contact with the liquid. This may be done
by moving the tip to a ��3� ����/��. This height must be chosen to be permanently below the
liquid level, to prevent the aspiration of air. On aspiration, the tip follows the falling liquid level
(if so specified) according to the volume aspirated. The distance to follow is computed from
the known geometry of the (first segment of the) liquid container.

More elegantly, and with greater safety, the liquid level of the vessel to be aspirated from can
be detected. This can be provided by STAR’s ��4�� ���.���0���!���� (LLD) feature, based
on either capacitive (cLLD) or pressure (pLLD) signal detection.  For conductive liquids,
capacitive LLD should normally be used. The sensitivity of the capacitive LLD that is to be
used depends on the vessel size and the conductivity (or polarity) of the liquid that is to be
detected. For a solution of 0.1% NaCl in distilled water, the sensitivities are:

!��0�������/ �������.��(���.�� 5�����

1 Very High 384-well plates

2 High 96-well round-bottom plates

3 Medium 96-well flat-bottom plates

4 Low Tubes



Microlab® STAR User Manual

Page 14 of 225                                                                                           610766/02


���

�������������������
�����$��������$�����
��
�������	�


����	
����$��

��	����
����
�
�%���


�

��
	
�	��������

���

��
���
$��������
�/���
	���
�����
������
����-���������
��������	��
�
�%����

�

��
	
�	���&��
�������
�	�������	��
�����
������������
������
�����
�!	��
�����������
�	
�"����������
�

For non-conductive liquids, or in case of an insufficient electrical coupling between container
bottom and carrier, pressure LLD should be used. Pressure LLD only works with new and
empty tips for the aspiration of liquids. The suitable settings depend on the tip size and on
the type of liquid.

300 µl channel:

&��0�������/ �������.��(���.�� ��& ��4�� 

1 Very High Standard Low boiling point, low viscosity

2 High Low Low boiling point, low viscosity

3 Medium Standard Water or higher viscosity

4 Low Low Water or higher viscosity

1000 µl channel:

&��0�������/ �������.��(���.�� ��& ��4�� 

1 Very High Standard Low boiling point, low viscosity

2 High High Low boiling point, low viscosity

3 Medium Standard Water or higher viscosity

4 Low High Water or higher viscosity

In the case of ��&�������������������/���4�� �, capacitive liquid level detection in particular
may not detect the surface properly. As an alternative, try pressure LLD, or a combination of
both. If you are using a combination of both LLD types, the maximum height difference
between the two independent LLDs can be used as a parameter.
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The following table gives dead volumes for both pressure- and capacitance-based liquid level
detection in various containers.

Labware Vmin/µl Carrier

Tubes, 16 mm x 100 mm 200 SMP-CAR-24

Tubes, 12 mm x 75 mm 150 SMP-CAR-32

Eppendorf tubes 1.5 ml 50 SMP-CAR-EPIL

Eppendorf tubes 0.5 ml 50 SMP-CAR-EPIS

96-well PCR plate (200µl/well) 50 PLT-CAR-L5PCR

96-well flat-bottom microplate 75 PLT-CAR-L5MD

384-well flat-bottom microplate 50 PLT-CAR-L5MD

96-deepwell microplate (archive) 150 PLT-CAR-L5AC

Once the liquid surface is detected, an additional immersion depth (typically 2mm) is reached
to prevent the aspiration of air, and���&������� starts. The tip follows the falling liquid level (if
so specified) according to the volume aspirated. Then, the tip leaves the liquid slowly and
heads for the vessel to dispense into.

Finally, to prevent droplet formation, a variable amount of transport air is aspirated. After an
aspiration step, the situation within the tip looks like this.

��
���	��	������	����	�
�	�������	�
������

���	
��������	����

T
i
p

Blowout air (optional, may
reach into channel)

Liquid

Transport air (optional)

Channel
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����#� 0��&����

The transport air that was aspirated at the end of the aspiration step is first dispensed with
the tip still in the air. Dispensing of the liquid may now occur in two different modes: to the
liquid surface or in a jet.

To ensure that the specified accuracy is achieved, volumes below 20 µl should always be
 ��&���� ��������4�� ������!�. For dispensing to a liquid surface use cLLD to detect the
position of the surface and then dispense by following the rising liquid level. For volumes
larger than 20 µl the liquid can be  ��&���� ������6�� without touching the surface. To
dispense in a jet specify a position a couple of millimeters above the surface and dispense by
following the rising liquid level. For dispensing in a jet, a varying amount of blowout air is
used to make sure that all liquid is dispensed from the tip.

However, dispensing to the surface of an empty vessel (touch off) is also possible� For
dispensing into an empty container, position the tip less than 1 mm (typically 0.4 mm) above
the bottom of the container and dispense, following the rising liquid level.

After the dispense, the situation within the tip looks like this:

��	��	�����������
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Dispense in Jet Dispense to Surface

T
i
p

Blowout air (optional)

Liquid

Transport air as specified
on aspiration(optional)

Channel

Transport air as specified
on dispense (optional)

Stop back volume
(optional)
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����%� ��&�0��&2���

The final step is to eject the used tip into the waste container of the Microlab STAR. A needle
will be placed back into the wash station, where the wash process may be started directly.

��#� �.�� ��/�	������������

If cross-contamination is a concern, consider the following approaches:

• Use only HAMILTON tips�on the Microlab STAR.

• Use new tips for every pipetting step to avoid carry-over between different wells or
containers.

• Use filter tips to avoid contamination of the pipetting channel by jets, aerosols, etc.

• Always dispense to a surface. Dispensing in a jet may produce aerosols and thus cause
cross-contamination.

• Always dispense using a residual volume, i.e., do not completely empty the tip on
dispense. This can be achieved e.g. by aspirating 10 µl and dispensing only 9 µl.

��%� ��4�� �	������7�)�&�����/��� ��7��� �����

In general, pipetting on the principle of air displacement (as with hand pipettes) is sensitive to

• the manner of pipetting (e.g. surface or jet),

• tip or needle type

• environmental effects (temperature, pressure, humidity), and

• liquid type.

The instrument’s behavior is determined by specifying the pipetting mode (e.g., surface or jet
mode) and the liquid class. Pipetting mode and liquid class represent two independent sets
of information which both have to be specified. For aspiration, three modes are possible:

• Simple “Aspiration”, for all standard cases,

• “Consecutive Aspiration” for aspiration with a tip that has already aspirated liquid,  and

• “Aspirate All” for aspiration of all the liquid within a cup (specify a volume larger than what
is expected within the cup). In this case, aspiration monitoring is deactivated and the tip
will follow the falling liquid level (if specified) to the bottom of the container, staying there
for the rest of the aspiration.

For dispensing, four modes are possible:

• “Surface Dispense Part Volume” for dispensing only a part of the liquid in the tip to a
surface, leaving a residual volume in the tip,

• “Surface Dispense Empty Tip” for dispensing all the liquid in the tip to a surface,

• “Jet Dispense Part Volume” for dispensing only a part of the liquid in the tip in a jet, i.e.
without touching a surface, leaving a residual volume in the tip,

• “Jet Dispense Empty Tip” for dispensing all the liquid in the tip in a jet.
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The ��4�� �!���� stores all relevant background parameters, such as flow rates and volume
corrections, for one pipetting cycle, i.e. for one aspiration and the subsequent dispense(s).
Depending on the pipetting mode chosen, only a subset of the parameters of the liquid class
is active. According to the different dependencies listed above, liquid classes have attributes
related to their intended use: tip type, liquid name, and dispense mode.

Different liquid classes are provided with the User Software and optimized for different
liquids, tip types, and important pipetting processes, such as aspiration followed by
dispensing either to a surface or in a jet. HAMILTON has optimized the standard liquid
classes with great care to assure the best pipetting accuracy. To change HAMILTON
standard liquid classes, store the class under a different name first. For special applications,
the user can define his or her own liquid class to achieve the highest accuracy with the
compounds and volumes of interest. For this purpose a Liquid Editor comes with the
Microlab STAR User Software.  It is described in Chapter 11 below.


���

�
��$����
�	�
����
�
�%�����
����������
�������	������������
��
��$�

��*	�
����

�����	��


���
�����
���
��
����$��
�

�	���	����	�
�	�������	�
��
�������

�	����	��	�
�������
��
��
����$�������

��%��� ��4�� �8�� ���/��3��&���

Here are some examples of frequently-used combinations of liquid classes and pipetting
modes:

�����&������≥�9µ�������:����2��1����4�� 7� ��&�����'�µ������������&�(�;+2:����&����<����
���� �� ���&�<�!���/����&���.��(�!(!��:

Liquid Class:        StandardVolume_Water_DispenseJet

Aspiration Mode: Aspiration

Dispense Mode: Jet Dispense Empty Tip

Detection: Aspiration: LLD = pressure or capacitance or both, submerge to a
depth of 2mm, following liquid level

Dispense: Fixed height of 5mm, not following liquid level

�����&��������:����2��1����4�� 7����/��� ��&������������&��2����� ��;+2:����&����<�������:
.��������&�<�!���/����&���.��(�!(!��:

Liquid Class:         LowVolume_Water_DispenseSurface

Aspiration Mode: Aspiration

Dispense Mode: Surface Dispense Empty Tip (in the liquid class selected here, the
blowout volume is 0)

Detection: Aspiration: LLD = Pressure or Capacitance or both, Submerge Depth
2mm, following liquid level

Dispense: Capacitance LLD on, following liquid level
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#����&������≥�9µ�������:����2��1����4�� 7� ��&�������������������������������&�(�;+2
:����&����<�1��&���&�=

Liquid Class:        StandardVolume_Water_DispenseJet

Aspiration Mode: Aspiration          

Dispense Mode: Jet Dispense Empty Tip (empty tip only)

Detection: Aspiration: Capacitance LLD, submerge depth 2mm, following liquid
level

Dispense: Fixed height of 5mm, not following liquid level

Comment: On first aspiration, pre-wetting of the tip by 1-3 mixing cycles is
necessary to equalize conditions for initial and subsequent dispenses.

%�����4�����/ of liquid means aspirating a given volume all at once and dispensing several
partial volumes (aliquots) in a jet to different containers. In this frequently-used pipetting
procedure, measurements have revealed that the accuracy of the first and the last aliquot are
often not within the specified range. Therefore, to dispense e.g. 10 aliquots of 20 µl of a
:����2��1����4��  with the ML-STAR, aspirate 240 µl and dispense 20 µl directly back into the
container. This is followed by dispensing 10 of the 20 µl aliquots. The last aliquot of 20 µl is
discarded into another container or ejected with the tip. In addition, after the dispense of
every aliquot, a given amount of air is aspirated and dispensed with the next aliquot.

Liquid Class: StandardVolumeWaterAliquotJet

Aspiration Mode: Aspiration

Dispense Mode: Jet Dispense part volume

Detection: Aspiration: Capacitance LLD, Submerge Depth 2mm, following liquid
level

Dispense: Fixed height of 5mm, not following liquid level
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The following table gives sample values and results for pre- and post-aliquot volumes
(please note that these are not technical specifications):
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	5A "A 	����

300 Std Water Yes 20 12 20 20   1.5 -2.6 A

300 Std Water Yes 50 4 50 20 2.0 -1.1 A

300 Std Serum Yes 20 12 40 40 2.0 B

300 Std Serum Yes 50 4 70 50 4.5 B

1000 Std Water Yes 10 12 20    >10 3.9 -3.8 A

1000 Std Water Yes 20 12 20 20 2.5 -3.2 A

1000 Std Water Yes 50 4 50 20 2.0 -1.5 A

1000 High Water No 20 12 20 20 5 -1.6 C

1000 High Water No 50 12 50 50 2.5 -1.2 C

1000 High Water No 100 8 50 100 1.5 -0.9 C

1000 High Water No 200 4 50 100 1.5 -1.5 C

1000 High Serum Yes 100 8 100 100 1.0 -1.1 D
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The Microlab STAR is equipped with an aspiration monitoring feature. During the aspiration
process, the pressure within the pipetting channel is measured in real time. Analyzing the
shape of the p(t) curve, the system can distinguish the following situations:

- A correct aspiration takes place.

- Air is aspirated into the tip (because, for example, the cup has not been filled properly).

- A clot blocks the tip.

The aspiration monitoring can be switched on and off for each individual aspiration step of a
method using the appropriate commands (see section 2.4). For pressure-based clot
detection, a threshold can be given in arbritrary A/D (analog/digital) values (typically 100 A/D
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values). The range of A/D values of the pressure sensor is from around 800 (at ambient
pressure) to <10 A/D values for 18 mbar below ambient pressure. For comparison, the
hydrostatic pressure of 100 µl of water in our standard tip is around 2 mbar.
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In addition to pressure-based clot detection, the ML STAR is equipped with capacitance-
based clot detection, too. This detection approach works for an aspiration with capacitance
liquid level detection switched on. The system measures the conductive signal when the tip
leaves the liquid after aspiration. Due to the air gap between tip and liquid, the capacitance
signal will vanish once a given height is reached (the “clot retract height”, which is specified
within the liquid class). If a clot is present, it bridges the distance and the signal will remain,
resulting in an error message. A typical clot retract height is 2-5 mm. This is illustrated below.

This clot detection is independent of pressure-based monitoring.

Clot Retract Height
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STAR stands for Sequential Transfer and Aliquoting Robot. The Microlab STAR performs
pipetting operations on liquids in containers placed on its work surface.

The basic model Microlab STAR contains a work surface, called a deck, for placing movable
carriers. These carriers hold reagent containers, such as tubes, microtiter plates, or other
kinds of labware.
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The Microlab STAR’s deck is divided into 54 equal tracks (T) for loading carriers with
predetermined positions.  This obviates the need for precise measurement of positions. The
deck has partitions for a maximum of 54 specialised 1-T carriers for sample tubes, or a
maximum of 9 6-T carriers for microtiter plates and CO-RE tips. An additional partition space
is provided for the tip waste container.

Carrier for tubes,
microtiter plates,
etc.

Waste
Container

Pipetting
Arm

Pipetting
Channel/
Pipetting
Head

Front Shield
and Window

z

x

y

(0,0,0)
Autoload
Unit

Loading
Tray

Deck
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The instrument’s internal coordinate system is shown in the figure, located at its origin.

The Microlab STAR is equipped with a pipetting arm typically containing 8 pipetting channels
which work independently. The pipetting arm can move in an X direction, whereas each
pipetting channel can move relatively independently both in a Y and a Z direction. The
Microlab STAR supports pipetting with disposable tips or with needles.

The pipetting channels have a set “travelling height” of 245 mm above the origin, or 145 mm
between the tip of the disposable tip and the deck of the instrument.  That means that when
a channel is to move from one location on the deck to another, it automatically does so at
that particular height.  This is a safety precaution, so that channels will not collide with any
items that may be on the deck.

The instrument is equipped with a front shield and a hinged transparent window made of
plexiglass. This window is equipped with a magnetic switch and it is locked during a run.

����
���


�������	
������!�	���
���$���
�����	�
�����	�������"������	��
��
�	��	
���(��$��
�

��	����
��	�
��������������������&��
����6.���
8����	�
��������

�&����	���	�

	�
����	���
�	��	��������	�
����
��	�
��������

#��� �&�����

Options are defined as components or configurations that are part of the instrument initially
provided to the customer as specified by that customer.  Options cannot be added later,
whereas accessories can (see Section 3.3 “Accessories” below). The instrument’s
configuration is set within the configuration editor of the User Software.

#����� %7�B7��������+�)�&�����/�	�������

The Microlab STAR comes with 4, 8, 12, or 16 pipetting channels working in parallel for
simultaneous transfer of liquids.

Instruments with 4,8, or 16 channels are best operated with carriers, holding microplates and
tip racks in landscape orientation (e.g. PLT-CAR-L5MD), whereas carriers with portrait
orientation for microplates and tips (e.g. PLT-CAR-P3MD) are best suited for the 12-channel
Microlab STAR.  In addition, increasing the number of channels to 12 or 16 reduces the
“random access space” of the Microlab STAR, i.e., the space that can be reached with all
pipetting channels. This is shown in the following table:

C����D�� C����D��
�����

	������� Rel. to Instr. Coordinate System

%����B 77.5 77.5 + 465

�� 113.5 113.5 + 393

�+ 149.5 149.5 + 321

The random access range of the different numbers of channels is indicated by brackets at
the left side of the deck layout display in the User Software (see chapter 6 for an account of
deck layouts).
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To guarantee random access to sample carriers, only the inner tube positions should be
used. The number of blank positions to be used for the different instrument configurations is
listed in the following table:

��)2	�"2#� ��)2	�"2�% ��)2	�"2��
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4 or 8 0 0 0 0 0 0

12 3 3 2 2 1 1

16 5 5 4 4 2 2

The 16-channel Microlab STAR is intended as a batch-type processor, i.e., random access to
all positions is not possible. By contrast with an 8-channel Microlab STAR, the methods for a
16-channel instrument should be set up in such a way that all positions are processed in
batches of at least 8 (or better 16, to optimize the pipetting speed) with 8 (or 16)
simultaneous aspirations or dispenses at identical x-coordinates (see section 8.9 for more).
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Different pipetting heads are available for the different volume ranges:

a) from less than 1 µl to 300 µl (for the use of low volume tips = 10 µl, and standard tips
= 300 µl), or

b) from 5 µl to 1000 µl (for the use of standard tips = 300 µl, and high volume tips =
1000 µl).

Currently, a mixing of high and low volume channels on one and the same instrument is not
feasible.
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The Autoload option, like the options mentioned above, belongs to the Microlab STAR
configuration initially specified by the customer and cannot be added later.

The autoload unit is a device enabling automatic loading of the Microlab STAR. It contains a
loading head that

• moves in an X direction,

• shunts carriers onto and off the Microlab STAR, and

• reads the barcodes of carriers, tubes, and microtiter plates.

There is a presence sensor that identifies the tubes present on a carrier.

Barcode reading is only possible in conjunction with the Autoload option.

Equipped with autoload, the ML STAR can read the following barcode types:

- ISBT Standard

- Code 128 (Subset B and C)

- Code 39

- Codabar

- Code 2 of 5 interleaved

- UPC A/E

- JAN/EAN8

Barcode Reader
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Accessories are defined as additional components that can be ordered later by the customer
and installed either by HAMILTON personnel, or by the customer. They include carriers, a
wash station, a temperature-controlled carrier and an automatic vacuum system, which are
described in this section of the manual. Note that the availability of accessories is subject to
change. Please ask for a current list.
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The labware is placed on special carriers which are loaded onto the Microlab STAR.
HAMILTON provides a wide range of standard carriers for microtiter plates, tubes, tips etc.
All standard carriers can be added to the deck by the user.

The naming of carriers follows a systematic nomenclature: E2C2F2���.

E: stands for the type of labware, placed on the carriers, e.g., TIP (= tips),

PLT (plates), SMP (=samples)

C=CAR for carrier

Wash Station

Pump Station
with 3 wash
solutions and
waste container

Heat Exchanger
for TCC

Controller for
Vacuum Box
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F: describes the labware details, e.g.,

�: landscape orientation

): portrait orientation


�����: number of items placed on the carrier (plates or tips)

�0: medium density (96- or 384-well microplates)

80: high density microplates (1536)

�	: 96-well archive plates

��� identifies the part number revision (e.g. A00)

�3��&��=� PLT-CAR-L5MD-A00 is a carrier for 5 medium density (96- or 384-well)
microplates in landscape orientation.

A carrier must always be identified (e.g in deck layouts and methods) by the unique
descriptor with which it is tagged.

#�#��� 0��&�������

CO-RE tips come in 3 sizes: low-volume, standard, and high-volume (approximately 10, 300,
and 1000 µl respectively). One blister pack contains 5 racks of 96 tips, giving a total of 480
tips. CO-RE tips are available in boxes of 4000-6000, depending on the tip size. CO-RE tips
are produced under sterile conditions, i.e. the tips are RNAse- and DNAse-free.

Reusable needles with 50, 300, and 1000 µl volumes may be used instead of tips. Only
HAMILTON needles and disposable tips should be used for coupling to the pipetting channel
of the Microlab STAR.

#�#�#� 
�� ���,�����������

The needle wash station is a device for the washing and drying of steel needles parallel to
the pipetting process. The wash station has the width of a normal microplate carrier (6T) and
is mounted on the deck of the Microlab STAR. All tubing and electrical connections are
routed through the docking station at the rear of the instrument. Along with each wash station
comes a pump station with three reservoir containers for wash solutions and a waste
container. This pump station is placed below the bench on which the Microlab STAR rests.
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The principle of the wash station is illustrated in the following figure, where a typical
procedure is shown.
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One wash station consists of three individual 8-fold wash modules ���� ���� ����� ��� ��
�(&�: High Volume (1000 µl), Standard Volume (300 µl), or Low Volume (50 µl).

To enable parallel pipetting with an 8-channel Microlab STAR, the following cycle of steps
takes place:

1. fresh needles are picked up from the first module for pipetting, used, and then placed
back into the same module. Washing starts.

2. fresh needles are picked up from the second module for pipetting, used, and then placed
back into the same module. Washing starts.

3. fresh needles are picked up from the third module for pipetting, used, and then placed
back into the same module. Washing starts.

4. The next set of needles is picked up from the first module again, which in the meantime
has washed and dried all 8 needles. The process is repeated again.

The needle wash station needs to be installed by a trained Hamilton engineer.
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The carry-over of the wash station depends on the wash program. Typical values are 10-5 to
10-6.

The wash parameters can be set within the User Software, prior to each wash step.
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For each of the two wash solutions (or wash and rinse solution), a set of parameters can be
specified:

- The G����������H�is the length of time liquid flows through the wash chamber.

- The G���1�����H is the length of time wash liquid is held within the wash chamber.

- The G���:�����H is given in millilitres per second for both wash liquids.

For the drying of needles an additional parameter is used:

- The G ������/� ����H gives the length of time allotted for draining the liquid from the
needles.

A set of default parameters is given for the wash process within the relevant dialog boxes of
the User Software.

To empty the waste liquid container or to refill the wash solutions, lift the container by the
handle. The valve at the bottom automatically closes, sealing the container. To reattach the
container, simply slot it back into its original position.
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Customers can order one of two complete variants of the wash station: “regular“, suitable for
most uses, and “chemical-resistant“, specially designed to meet the needs of those working
with aggressive chemicals. Each variant is complete with 3 wash modules and pump station.
For each variant there are high-, standard- and low-volume options.  The part numbers for
the various options are given in the table below:

Regular Chemical-Resistant

Low Vol. 182575 182722

Std. Vol. 182574 182721

High Vol. 182573 182720
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Wash Solution One: red,
2 right-most containers (2 x 3 L)

Wash Solution Two: blue,
left-hand container (1 x 3 L)



Microlab® STAR User Manual

610766/02                                                                                           Page 31 of 225

:�
����
��
���	���
������	��	�
���
$����	
���������	�
��


�	������������
�%�������
���������
�

���
��
��
�	�������������
���������	����
���������
�%���������
������	�9���	$&����	�����	���&
���
����	
�	���&�
	��

����
���


��
��

�

�������	�	�������������
�������������	�
9�
����� ���������
���������
��	���
�����

����
9�
����
��
��������������&�	�
��
�
����$���
���	��������	��

	��
��

#�#�%� ���&�������2	�������� �	�������I�		J

The temperature-controlled carrier is a device to heat and cool microplates. The TCC has
four positions for microplates, which are all of the same temperature. The TCC may heat
microplates up to 60°C, or cool them down to 22°C below ambient temperature. The TCC is
able to read barcodes on the microplates (with the autoload option). It consist of a plate
carrier with peltier elements on the instrument deck and a service station with a heat
exchanger  below the bench. For the heat exchanger, a water-based heat exchange liquid is
used in a closed cycle; it is stored in a reservoir.

Typical times (at 40% rel. humidity) to heat and cool the TCC are (Tambient = 20°C):

Tambient  to 60°C 20 mins

60°C to Tambient 20 mins

Tambient  to 4°C 15 mins

4°C to 60°C 25 mins
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The TCC will be installed by a trained Hamilton service engineer. A maximum of 2 TCCs can
be placed on one Microlab STAR.
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The Automated Vacuum Box System consists of a vacuum box, a vacuum controller and the
controlling software. The Vacuum Box is fitted to the deck of the Microlab STAR and is
controlled by the workstation‘s computer. For this integration, a special deck has to be
mounted on the Microlab STAR. The vacuum box accommodates a wide variety of 96-well
filter and collection plates and is automated, so that the filter plate can be transported from a
waste/conditioning chamber to an elution chamber. The vacuum box is compact and a
maximum of two can be used in parallel on the Microlab STAR deck with the same controller.
Filter plates can be placed onto or removed from the system by hand or with the help of a
robotic arm (see the section on iSWAP below).

The vacuum controller allows for user-defined vacuum settings. The software integrates
seamlessly with MICROLAB Vector.  Loading is handled with a step in the method.

We now turn to a description of the components of the automated vacuum box system.

����������

The picture on the left provides a bird’s-eye view of the vacuum box, showing the
conditioning chamber on the right and the elution chamber on the left, which is covered in
this picture by the carriage. A lid gasket in the carriage provides the sealing surface for the
filter plate and a chamber gasket provides the sealing surface for the carriage. In the picture
on the right, the carriage is on the way to the elution chamber.

The picture above shows the ports on the vacuum box.  There are three ports into which is
fed the tubing that goes to the vacuum box controller. There is also a push-button switch that
allows the user to manually operate the carriage. An electronic control port is used for power
and communication.
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One Controller can control up to two vacuum boxes. The front of the controller has eight
ports. Six of these are needed for conditioning, elution and waste removal. There is also a
vacuum exhaust port for venting vapors and a “waste out“ port for draining liquid from the
conditioning chamber.

Pictured above is the right side of the controller with the different connections. The
communication with the computer is via a USB cable. As the controller requires 24 volts, a
power supply with 24 volts is delivered together with the controller.

Vacuum Box 1
Vacuum Box 2

24 Volt Power Connection

Connection to the
Vacuum Box 1

Connection to the
Waste Box

USB Connection to the
Computer
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The waste is collected in the closed-system
waste container with liquid level monitoring
to prevent overflows.
The waste container with a volume of 10 litres
should preferably be placed below the level
of the instrument. The waste level sensor
has to be connected with the controller.

The AVS and its components are to be installed by a Hamilton service engineer.

#�#�+� ��,�)

The iSWAP (internal Swivel Arm Plate Handler) transports microplates, covers of
microplates, archive plates or filter plates used for the vacuum box to and from
positions on the deck of the Microlab STAR IVD. The plates can be placed in
landscape or portrait orientation and rotated 180 degrees. In addition, the iSWAP is
able to load and unload plates to and from a plate stacker on the left side of the
instrument outside the working area (with some restrictions, this can also be done on
the right side). Like Microlab STAR’s pipetting channels, iSWAP has a “travelling
height” of 145 mm above the deck (245 mm above the origin).

The iSWAP is mounted on the pipetting arm and parked below the cover of the
pipetting arm. In this position it does not affect the movement of the pipetting
channels.

�����.�����	�������

iSWAP can be chosen by the customer as an ordering option, but can also be installed later
by a service technician at the customer’s request.
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The Microlab STAR is controlled by a dedicated user software program which controls all
functions for daily work routine, method programming, running methods, and other services.

The Microlab STAR and the computer controlling it may be linked in two different ways:

- By a serial interface (RS232), or

- By a Unified Serial Bus interface (USB).

The Microlab STAR automatically recognizes the type of communication in use.

The Microlab STAR requires a recent model of PC including a mouse, CD-ROM drive, high
resolution monitor and graphics (SVGA or better), 1-2 serial ports for a USB, about 1 GB
HDD and ≥128 MB RAM, and Windows 2000 (service pack 1 or better) as the operating
system.

To avoid any loss of data, we recommend a UPS (uninterruptable power supply) for the PC.
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The Microlab STAR User Software is the controlling software for the Microlab STAR.

It is a WindowsTM-based, menu-driven interface allowing the user to define deck layouts and
methods, and then to run the Microlab STAR.

The Microlab STAR User Software allows the user to program and run different methods for
aspirating and dispensing liquids.
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Firmware is the set of instructions that are downloaded to the Microlab STAR by the
manufacturer to enable the instrument to carry out its functions. Normally, the User Software
is used to control the instrument. However, the Microlab STAR can be controlled directly with
the CoCo firmware protocol (CoCo means ’Communication and Control’). This is done by
controlling actions of the Microlab STAR with single firmware commands. Firmware
commands  are listed  in the �
����
������
 for the use of Hamilton engineers servicing the
instrument.

#�'� ��������������� ����2$&

The Microlab STAR will be unpacked and installed and initial set-up performed by a trained
HAMILTON technician.  The customer need only ensure that a suitable control PC is
available for installation of the ML STAR User Software.

Make sure that the Microlab STAR is connected to a 115 to 230 V AC (50 or 60 Hz) socket.
The Microlab STAR automatically recognizes any voltage within that range, without user
intervention. Select the appropriate voltage at the pump station of the needle washer. The
needle washer does not recognize the voltage automatically.
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We recommend using a Uninterruptible Power Supply (UPS) for the Microlab STAR.

Ensure that the instrument is correctly earthed when connected to the power supply.

The mains plug is on the left hand side of the instrument towards the rear (see picture 1
below).

The fuses for the instrument are situated in the mains power switch (see picture 2 below).

Plug the mains cables for the computer and the instrument into the same electrical outlet.
Connect them only to an earthed outlet.
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The technical specifications regarding electrical power are listed in the following table.

Maximum power consumption:

Voltage:

Frequency:

Delayed action fuse:

115 V∼:

   230 V∼:

600W

115 / 230 V∼ -15 % + 15 %

50 / 60 Hz ± 5 %

6.3 A

3.15 A

Overvoltage category II

Degree of pollution 2

Fuses

Voltage selector

Always at 220 – 240 V
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The needle wash station has its own power supply. The mains plug is on the rear of the
pump station (see picture  below).

Ensure that the the needle wash station is correctly earthed when connected to the power
supply. Connect the wash station only to an earthed outlet.

Ensure that the voltage selector is correctly set before operating the needle wash station.

The fuses for the instrument are situated next to the mains power switch (see picture  below).
The pump station has two fuses for the power supply which can be accessed by opening the
cover above the mains plug.

� -��
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The technical specifications regarding electrical power for the wash station are listed in the
following table:

Maximum power consumption:

Voltage:

Frequency:

Delayed action fuse:

115 V∼:

   230 V∼:

  140 W

115 / 230 V∼ -15 % + 15 %

50 / 60 Hz ± 5 %

 3.15 A (T3.15L250)

   1.6 A (T1.6L250)

Overvoltage category II

Degree of pollution 2

Voltage Selector

Fuses for power
supply
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A short preventive maintenance including volume verification should be carried out twice
yearly. Typically, the service and volume verification are carried out by a trained HAMILTON
service engineer.

To clean the instrument deck use the procedures required by GLP. To preserve plastic
materials from damage, do not use organic solvents.

If a spray is used, do not point the spray directly at the autoload unit or at electrical boards or
connectors.

#�B� 5�����!�����

The Microlab STAR will be verified by a trained HAMILTON technician upon initial set-up,
and thereafter at regular intervals for a period of time specified by service agreements.
HAMILTON recommends that this verification take place four times yearly.

For volume verification in the field, HAMILTON will supply a verification tool, based on
gravimetrical measurements (the “gold standard” of volume verification).  The detailed
specifications are listed in the specification table at the end of this chapter.

Conditions are valid only for the HAMILTON verification kit.

#�;� 0��&����

After the life cycle of the instrument has terminated, the Microlab STAR may be shipped to
the original manufacturer or retailer. Otherwise local disposal regulations are to be observed.

#��9� �������/

Training in operation of the Microlab STAR and the User Software will be provided by
HAMILTON personnel upon initial set-up.
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The pipetting specifications for the Microlab STAR are given in the following table. The
differences in the specifications are due to the accuracy of the gravimetrical measurement,
which to a great extent depends on the quality of the balance, as well as on the stability of
the environmental conditions (pressure, humidity, temperature).

#99�µ��I��:�5�����J�)�&�����/�	������

0���/���&�!� ������������/��&�!� ���� �5�����!�����
�&�!�

5���Dµ� 5	��Dµ� K"KDA 	5DA K"KDA 	5DA K"KDA 	5DA

200 300 1 0.75 1.5 1 2 1.5

50 300 2 0.75 2.5 1 - -

10 300 5 2 6 2.5 - -

5 10 2.5 1.5 3 2 6 5

2 10 5 3.5 6 4 - -

1 10 5.0 6 - - - -

�999�µ��I8�/��5�����J�)�&�����/�	������

0���/���&�!� ������������/��&�!� ���� �5�����!�����
�&�!�

5���Dµ� 5	��Dµ� K"KDA 	5DA K"KDA 	5DA K"KDA 	5DA

1000 1000 1 0.75 1.5 1 2.0 1.5

500 1000 1.5 0.75 2 1 - -

200 300 1 0.75 1.5 1 - -

100 300 1.5 0.75 2 1 - -

50 300 2 0.75 2.5 1 - -

10 300 5 2 6 2.5 9 6
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The design specifications mentioned above are valid under the following conditions, obtained
for measurements at HAMILTON Bonaduz:

• Test method: Gravimetric testing at Hamilton. The scatter of the test method must
be less than 1/6 of the specified precision (for one channel).

• Trueness/Precision The values given refer to use of 8 pipetting channels.

• Test size: ≥ 12 single pipettings per channel with disposable CO-RE tips (pick-
up and dispense, tip used only once) per channel and specified
volume

•    Test mode: Volumes ≥ 20µl as jet dispense, < 20µl as (liquid) surface dispense

• Acceptance criteria: Measured values are within specifications if less than the values
appearing in the table on p. 40.

• Test temperature: 20 ± 2°C

• Test fluid Deionized water with 0.1 % NaCl, 0.01% Tween
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The Microlab STAR User Software is the controlling software for the Microlab STAR.

It is a WindowsTM-based, menu-driven interface allowing the user to define deck layouts and
methods, and then to run the Microlab STAR.

The Microlab STAR User Software allows the user to program and run different methods for
aspirating and dispensing liquids. Note that each programmed method has to be validated by
the user.  The deck layout is defined within the Deck Layout Editor, whereas the aspiration
and dispense steps are defined using the method editor. An independent run control is used
to run the methods programmed.

For ease of use, there are two different options for programming. In both cases, a “master” or
central editor is selected, which can either be the method or the deck layout editor. Whatever
editor is started first is the master editor. All other (“slave”) editors and the run control are
then called from the master editor, using easy access shortcut buttons. If you make changes
within one of the slave editors, the master editor is automatically updated once you quit the
slave editor. This is illustrated below with the deck editor as master:

Deck Editor is Master Method Editor is Slave

Run Control is Slave

Labware Editor: Auxiliary

Sequence Editor: Auxiliary
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Alternatively, the user may start with the method editor as the master editor (if there is no
shortcut to the method editor, create it manually. The relevant executable file is
...\hamilton\bin\HxMethEd.exe):

The auxiliary modules and tools (small arrows in the above figures) are called from the tool
menu by menu items or tool icons. Finally, the method is executed using the independent run
control.  In some cases, one may wish to define special labware items or sequences
(pipetting patterns - see below) using the labware editor and the sequence editor.

%��� ����� ���� �0�!1���(����

The Microlab STAR User Software allows an �,� relation between deck layouts and
methods. This means that one deck layout may be used for different methods or one method
uses different deck layouts, e.g., to link two Microlab STARs, or a Microlab STAR and a
Microlab SWAP.

The run control allows you to start either deck layouts (with the corresponding method if
there is only one), or, in general, methods. These methods are then either executed or
simulated.

Method Editor is
Master Deck Editor is Slave

Run Control is Slave

Labware Editor:
Auxiliary

Sequence Editor:
Auxiliary
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Due to the �,� relation between deck layouts and methods, the “Save as” option needs to be
used in the following way:

To save a method under a different name, still referring to the old deck layout:

• Select “Save As” in the method editor and save the old method A under a new name B.
The new method B is still linked to the old deck layout A.

To save a method and the corresponding deck layout under a new name:

• Start the Method Editor as the (first opened) master editor.

• Select “Save As” to save method A under the new name method B.

• Start the Deck Editor to save deck layout A under the new name deck layout B. Close the
Deck Layout Editor.

• Link method B to deck layout B (Methods->Instruments). Save method B.

%�#� ����!������������$��������:���

The User Software consists of a set of modules and tools (programs) which work together.
These modules and tools are grouped into a general (instrument-independent) and a specific
(instrument-dependent) group. Given that structure, a system with different HAMILTON
instruments (even non-HAMILTON instruments, suitably adapted) can be controlled and
operated in the same manner, in the same environment and at the same time. The general
modules get all the specific information they need about instruments (such as pipetting steps,
or information about the probe head) from the instrument-dependent modules.

The general modules with a common “look and feel” for all HAMILTON instruments include:

• Deck layout editor (for mapping the position of labware on the deck)

• Method editor (for programming methods)

• Sequence editor (for defining pipetting sequences)

• Labware editor (for defining custom labware to be used in deck layouts)

• HSL Method editor (for programming methods using text entry mode)

• Run execution (for running methods on the instrument).

The general tools include:

• Version info.

The Microlab STAR-specific editors include:

• Liquid Editor (for defining liquid classes)

• Configuration Editor (for configuring the User Software to a particular instrument)

The Graphical Method Editor lets the user write methods in a graphical, syntax-free
environment. Technically, this editor is a code generator producing a low-level code which is
then interpreted by the run control. This low level code is called HSL (Hamilton Standard
Language), because it provides a common programming approach for all Hamilton
instruments. HSL can be accessed directly using the HSL Method Editor. HSL is a syntax-
dependent language that offers even more flexibility than the Graphical Method Editor. The
instrument-specific steps (e.g. aspiration, dispense - see below) are the same for the
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graphical and the HSL method editor. The general syntax used in the HSL is the C/C++
notation and associated language constructs.

%�%� �!!����"�/���

The User Software does not define any user access restrictions. However, specific access
rights may be restricted to trained users within the operating system, or by applying write-
protection to specific files.
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The installation generates the following default directory structure, if not requested otherwise.

Note in particular the file contents of the following directories:

���: Executables, DLLs

	����/: Configuration Files

���:���: Labware Definitions

��/�����: Com Traces (Port Trace), Tip Counter File (TipCount.xls)

����� �: Methods (*.med, *.hsl), Deck Layouts (*.lay), Method Traces (*.trc)

������(: HSL libraries of commonly-used additional functions

!=L���!� ���In addition, this directory is used by the sample tracker to store Microlab AT-like
barcode and register files.
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As described in Chapter 3, the Microlab STAR is available in several variants. To configure
the User Software to a specific instrument configuration, the Configuration Editor is available
within the Deck Layout Editor under Tools->Configuration:

The first decision to be made - prior to a run - is whether to run the method with the
instrument or to simulate the run without using the instrument. Run simulation is a tool to test
whether a method has been programmed correctly. The run simulator creates a method
trace file with pipetting pattern and other useful information.

Click the Advanced button to access the instrument configuration screen. Different tabs are
visible:

��
�	���(��	���
�	����������	���

Select your instrument configuration. Waste16 (as in picture above) is the correct sequence
of the waste container for disposable tips. Teaching mode refers to the possibility of
“teaching” positions on the instrument deck, which can be done moving the arm by the
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keyboard or by a teaching box (accessory). The channel to be used for “teaching” is to be
specified, too.

The next tab refers to barcode handling:

The different barcodes which are allowed on the instrument can be selected here. In
addition, the generation of a barcode trace file (barcodes_N.txt) can be switched on and off,
storing rack barcode and track position on deck as well as tube (or plate) barcodes and
positions within the rack. The sample tracker, which generates a database of liquid transfers
in the background can be switched on here, too. This sample tracker is used to generate a
Microlab AT-like barcode file using a special filter tool.

The error settings tab allows you to specify the step width in mm for blood clot error recovery
(the channels move up on request by the step width). The return string separators are used
to define the syntax of single step return values.

The step selection finally allows you to exclude steps such as the move commands from the
method editor.
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Only if “instrument” is selected within the configuration editor is the additional tab
“communication settings” visible.

Select the type of communication and the com port for communication via RS232 interface.

Click “save” to activate the new settings or “abort” to leave the settings unchanged.
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In the Hamilton Deck Layout Editor, the user is prompted to tell the system which labware
(carriers, racks, or containers) is to be used in the procedure, and where these items are
placed on the deck. This is called “defining a deck layout”.

The 'Hamilton Deck Layout Editor is started by double-clicking the shortcut icon displayed on
the desktop of your PC.

�
���
�$��	�
��	��

The method editor and the run screen can be started from the deck layout editor by clicking
the appropriate buttons located in the leftmost frame.

For access to the main modules, a toolbar is provided. In that toolbar the following choices
are available (some of which are deactivated):

• New deck layout

• Open deck layout

• Save deck layout

• Method editor

• Run execution

• Labware editor

• Sequence editor

• Zoom in deck layout

• Zoom out deck layout
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Under the File menu or in the toolbar, select New to start the definition of a new deck layout.

If multiple instruments are installed on your PC, a dialog window will appear.  Select an
instrument (e.g. ‘ML_STAR’ for Microlab STAR) and click OK. If there is only one instrument
installed, the template (base definition of a deck layout) of that instrument is shown directly.

�


�	�(��	���
�	�������

The deck layout displayed below shows the tracks of the predefined grids from the
appropriate deck template.

+9���
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Use the (+) zoom button to enlarge the deck view.

A deck template is an instrument-specific definition of dimensions, main grid and hidden
grids, with preloaded standard labware such as a waste container.  Deck templates can be
customized.
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The complete loading of the deck may be stored under a chosen file name (extension: “.lay”),
e.g. “MyDemo.lay”. This is done using the Save, Save As... commands in the File menu.

After a deck layout has been defined and saved, you are ready to start programming your
method.

+����� �&����3�����/�0�!1���(����

It is possible to load previously defined deck layouts (extension “.lay”) by selecting “Open”
under the File menu.

+��� �  ��/����:�����������0�!1���(���

Basically, the deck is freely configurable.  The term labware refers here to carriers (available
from Hamilton) as well as microplates (from various manufacturers) and tip racks. The
general procedure is first to add a carrier for a special kind of plate to the deck and then add
the plate to the carrier. There is a restriction, however, that carriers ������
�	$�
����������
�	

��
$ are available as standard parts. Therefore, do not place a deep-well microplate and a
flat microplate (for example) on the same set of vertical positions in the deck layout.
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The software comes with a set of ready-made labware definitions for the standard labware
items that are most commonly used in laboratories. The carrier name and definition selected
must always be identical to the name with which the physical carrier is labelled.

Here are some frequently used Hamilton standard carriers:

- Plate carriers for 5 flat 96- or 384-well microplates PLT-CAR-L5MD

- Plate carriers for 4 1536-well microplates PLT-CAR-L4HD

- Plate carriers for 5 96-deepwell (or archive) microplates PLT-CAR-L5AC

- Tip carriers for 5 tip racks of 96 tips each TIP-CAR-480

- Preloaded carriers for 32 or 24 tubes with defined diameter and length
CAR24_Cup15x75

- Plate carriers for 5 96-well PCR microplates PLT-CAR-L5PCR

- Plate carriers for 3 96- or 384-well flat microplates in portrait orientation PLT-CAR-L3MD

- Plate carriers for 3 96-deepwell microplates in portrait orientation PLT-CAR-L3AC

- Carrier for 12 reagent containers of 100 ml each REA-CAR-L3AT

- Temperature-controlled carrier No 1 and No 2 CAR_TCC_1, CAR_TCC_2

- Wash Station No 1 and No 2 for needles: CAR_Wash_1_LowNeedle, etc.
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Carrier definitions are stored under ...\hamilton\labware\ML_star. Files defining carrier
templates have the extension *.tml. A carrier features a varying number of locations for the
placement of labware, such as tip racks, microplates, etc.

To add a carrier to the deck layout, simply double-click on the appropriate track position. The
“add labware” dialog box opens up. Type in a name for the carrier and click browse to select
the PLT_CAR_L5MD from the \labware\ML_star directory. Click OK in the “add labware”
dialog.

 The carrier is now added to the deck layout.

The next step is to add a plate to this carrier. The corresponding labware (plates, tip racks,
etc.) is sorted by manufacturer and stored within the Labware directory. Standard plates from
almost every major manufacturer are available:

- Nunc

- Falcon

- Greiner, etc.
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Microplates, tip racks, etc. are  labware items and generally called “racks”. The defining files
have the extension “.rck”

To add a plate to the carrier, double-click on the desired carrier position. Again, the “add
labware” dialog box opens. Select the Nun_96_Fl_L.rck (96-well flat-bottom Nunc plate in
landscape orientation) from the labware\nunc directory. Give a name to the plate, e.g.,
“MyPlate”.

The plate is added to the site. Plates (or labware) may be moved between sites on one
carrier by simple drag-and-drop.

Besides plate and tip carriers, tube carriers can also be placed on the deck. These carriers
are preloaded with tubes of a defined size (diameter and length). In fact, these carriers are
racks (*.rck) in contrast to the other carriers, which are carrier templates (*.tml). The tube
carriers are an example of racks which fit directly into the track grid of the Microlab STAR.
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To place labware (e.g. microplates) directly onto the deck (without using a carrier), select
“Add Labware” from the Edit Menu. A dialog window opens up: Select the type of labware
from the library and enter the x,y,z coordinates by hand.

You may enter a name by which the rack will be known on the deck.

In the type field, select the already listed labware item or press Browse to load another
labware item to the list. Click OK.  If the labware position falls outside the instrument deck, a
message window opens to inform you.

Use the 'Rotate' button to rotate the labware item in increments of 90 degrees and type the
position in X,Y, and Z coordinates into the input boxes under Deck Position. Click OK.

If the labware item is to be placed at an angle other than 90, 180, 270 or 360 degrees, the
'Free form' mode will have to be used. Here, two sets of coordinates are required.
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“Teaching” means guiding a channel or other probe to a particular location on the deck and
assigning a name to that location.  The User Software enables you to record the x-y-z
coordinates of that point and to associate them with the name you have given the location.
Afterwards, you need only specify the name of the location and ML-STAR “remembers”
exactly where it is on the deck. The precise position of labware items can be “taught” in this
way, using the needle from the teaching station. This is an accessory. The teaching station is
placed on track 55, next to the waste container.

��
�	
��������	�	������	���

�

�

Right-click on the labware to be “taught” within the deck layout. Select “Move Labware” from
the menu. Click on the Move Probe button. A needle is picked up from the teaching station.
Note that the teaching station does not have to be added to the deck layout  (software).
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The dialog gives the current x,y,z coordinates and allows you to move the needle to any
position on the deck. The Advanced section allows you to move directly to a position by
clicking on Move Probe.

Clicking on Key Control brings you back to the previous dialog. Clicking OK ends the
teaching process and writes the current position into the x,y,z coordinate fields of the move
labware dialog.

Alternatively, select “Move Probe” from the tools menu.
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It is possible to add additional labware to the deck any time by the procedures described so
far.

To delete labware items from the deck, right-click the item to be deleted and select “Delete“
from the menu. In the message box that appears, click OK. The item is deleted from the
deck.

To rename a given labware item, right-click the item to be renamed and select “Rename“
from the menu. In the message box that appears, change the name and click OK. The item
on the deck is renamed.

To get the properties of a labware item, right-click the item of interest and select “Properties“
from the menu. The message box that appears will display the type and the name of the
item.

For the definition of custom labware objects, refer to chapter 15.
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A sequence is a defined series of pipetting events involving the transfer of liquid from one
container to another. A sequence defines the order of containers in a rack.  For example, it
links the single wells of a microtiter plate together so as to treat them as one plate. When the
probe is pipetting, it will follow this order (channel No 1->Sequence Position No 1, channel
No 2 ->Sequence Position No 2, etc.) unless instructed to do otherwise.

A sequence such as the one shown below has three pointers (or important positions) which
may change during a run:

- The current position (which is the first unused well in the current situation),

- the end position (the last position to be used for pipetting), and

- the total number of elements (the overall length of the sequence).

Consider this example:

     1         2        3         4        5        6         7        8        9        10       11      12

                                      ↑                                                            ↑                             ↑

	�������)��� �� �)��� ��������������

Within the method, all three positions may be altered or requested by the appropriate
functions.

A standard sequence is created automatically when the rack is placed on the deck. Custom
sequences can be defined graphically by selecting the appropriate wells in the Sequence
Editor, or “on the fly“ within the programming of the method.

In methods defining the pipetting steps to be performed, only the sequences and not the
actual labware items are referred to.  Pipetting always occurs according to a sequence.

-��� ��4���!��� ����/

To edit or change sequences, start the sequence editor by selecting Tools->Sequence Editor
in the Deck Layout Editor.  The Sequence Editor is illustrated on the next page.  When the
sequence editor is started from the Deck Layout Editor, a new untitled sequence is created
automatically.  Add labware positions to this sequence by selecting (clicking on) positions
(wells) in the deck layout view.  The standard left-click, shift-left-click, control-left-click, and
rubber-banding rectangle are available for selecting positions in the deck layout view.

As positions are added to the sequence, they are displayed in the grid in the left pane of the
window.  The grid contains one row for each labware position in the sequence. The order of
the rows in the grid can be changed by standard cut, copy, paste, drag, drop, and delete
operations, thereby changing the order of the positions in the sequence. The grid has a fixed
width.  X, Y, and Z columns may not be initially visible.  Moving the vertical splitter or the
horizontal scroll bar will allow these columns to be seen.  Sequence information cannot be
typed directly into the grid.
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Additionally, the functions of the sort/filter panes can be applied to the selected rows of the
grid (if selected)  or all grid contents.  Once the labware positions in the sequence are in the
desired order, save the sequence.  Saving fixes the order of each row in the grid as the order
of the labware positions in the sequence.  On saving, you are requested to give a name to
the sequence.

Any existing sequence in the deck layout can be activated for viewing and/or editing by
selecting the sequence name in the drop-down menu.  Additional labware positions can be
inserted in the active sequence by selecting them in the deck layout view.  Existing positions
can be removed.  Positions can be reordered as described above.  The sequence can be
resaved to fix its positions according to the new order.

The tree view in the left pane displays the sequence from a tree-oriented perspective, where
the tree’s leaves are the positions in the sequence.

-����� �  ��/�)����������������4���!�

Use the mouse to select labware positions to insert in the sequence as follows.

1. Left-clicking on labware position adds the position to the sequence.  That means it either
(a) inserts it in sequence ahead of the (first) selected row in the grid, or (b) appends the
position after the last row in the grid if no rows are selected.

2. Rubber-banding a rectangle of wells adds a block of positions to the sequence.  The
block of positions is added in a manner similar to that employed when adding a single
labware position.  The block of positions is ordered according to default sequence for all
labware object(s) involved.

3. Control-left-click on labware position toggles the position’s status in the sequence.  That
means it inserts the position in the sequence if it’s not already there (same as left-click on
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labware position), otherwise it deletes the position with the largest sequence number
from the sequence.

4. Shift-left-click on labware position adds a block of positions to the sequence.  That means
it adds all positions in the rectangle whose first corner has the coordinates of the most
recently added position and whose opposite corner has the coordinates of the newly
selected labware position.  The block of positions replaces the most recently added
position and is ordered according to default sequence for all labware object(s) involved.
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Play first deselects all positions in the sequence, then plays the sequence. As each position
is selected, it is painted in the deck-layout view and highlighted in the grid and tree views.

Play can be paused at any time and resumed by clicking on play again.

-���#� ������/�"�!1�

The “Sort Racks” dialog allows you to apply an order to labware positions in the active
sequence.  The order is applied to the currently selected labware positions, or to the entire
sequence if no positions are selected.

Use this filter to create processing sequences across multiple racks in the direction required.

-���%� ������/��(�
�� �	������

The “Sort by Grid Columns” dialog allows you to sort the contents of the grid based on
specified criteria.  Left-most combo boxes contain the grid’s column headers: #, Labware,
Position, X, Y, Z, and “(none)”.  Right-most combo boxes contain “ascending” and
“descending”.  The sort is applied to the currently selected labware positions, or to the entire
sequence if no positions are selected.
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The “Sort by Grid Rows” dialog allows you to sequentially order every �-th row in a grid
beginning with the H-th row.  The sort is applied to the currently selected labware positions, or
to the entire sequence if no positions are selected.

The sequence will be re-ordered by selecting the �-th grid row and moving that row to the
“next” position.

-���+� ��������(�)�����8�� 

The “Filter by Probe Head” dialog allows you to (a) apply an order to labware positions in the
active sequence, then (b) remove positions where the probe won’t fit.  These functions are
applied to the currently selected labware positions, or to the entire sequence if no positions
are selected.  The first function, (a), is optional.

Initial values for this tab are taken from the instrument’s configuration file.  These initial
values can be recalled using the Defaults button.
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Here is an example of how rack sorting works.  Given the following sequence across 2 racks,
apply the Sort Racks filter, defining a direction across the racks.
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The sequence is re-ordered across the racks as follows:
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The same initial sequence if sorted using Sort by Grid Rows will result in the following:

In this case the initial sequence was:

Rack1 A1, B1, C1, D1, E1, F1, G1, H1

Rack2 A1, B1, C1, D1, E1, F1, G1, H1

Taking the 4th row after the first row gives

Rack1 A1, E1,

Rack2 A1, E1

Rack1 A1 is gone, so Rack1 B1, F1

Rack2 B1, F1

Rack1 B1 is gone, so Rack1 C1, G1...  And so on.
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Methods are short programs that string a number of specified commands (such as aspirate
or dispense) together to instruct the instrument to perform a function. They can be as
complex or as simple as the user desires. Access to a method editor is necessary to define
or edit methods.

The Graphical Method Editor�is a syntax-free editor that presents a batch-like graphical
editing environment. Common constructs such as loops, conditionals and built-in functions
are supported by this editor. It also provides a variable management system.  This system
simplifies variable usage by allowing implicit declarations and by supplying complete variable
context to edit dialogs.  The output of the Method Editor is a linked set of files that may be
executed by the �������

� or further customized using the /�)��
	����+��	�� (see chapter
'�/�) Method Editor, page 96).

In most cases (but not necessarily), a method references one single deck layout. The
�
	����+��	���is accessed by clicking on the +��	��
	��� button in the �
���)�$��	�+��	��,
after the deck layout has been defined and saved, e.g. as “MyDemo” (.lay). Alternatively, the
method editor may be started directly from the desktop.

�
	����+��	��

The Method Editor�is divided into 2 sections:

The ��
�����
�� on the right is a grid containing the method.

The ���������
�����on the left offers various elements that can be used to build the
method, grouped by bars.
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At the beginning of a new method, there is only one bar named I
�
��
, containing the
common language elements such as �� 

�
, 
���, ����	������

, etc. No instrument-specific
steps (e.g., aspirate) are visible so far.
All ���&��!������ ������ D������ ������4���� by right-clicking a step or a block of steps
and selecting disable/enable from the menu.
It is possible to load different methods into the editor and !�&(����&�����:�������
����� �.

B��� 
������������ �	����� �

A detailed description of all commands in the general method editor is directly available from
the software. Invoke the Help menu for more information.

A number of standard commands are available, as you can see from the figure below.  For
an explanation of the command buttons on each line (numbered for convenience), see the
listing following the figure.

Whatever input is necessary for the individual commands, all input fields labelled with text in
brackets [�
�����	���] contain optional information or the default may safely be accepted.

I
�
��
����������
��	����������� �����	�
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1
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5

6

7

8

9

10

11
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- 	������: For any user-defined comments in a method

- ����/�����: assign a variable

- ����/������:����!��!�������: perform calculations

�:�����������
��
�@

- ���&: Loop commands between start and end of loop

- ���&�����1: Terminates a loop

- ��2����7�����: Condition command

:�����������
��
�2

- ��4���!�: Get current position

- ��4���!�: Set current position

- ��4���!�: Get end position

:�����������
��
�C

- ��4���!�: Set end position

-���4���!�: Adjust sequences

- �&�������: To open a file before file operation

:�����������
��
�>

- "�� ����������: Read data out of a file

-�,������������: Write data into a file

- ����&�������: Set the file-pointer to a specific position

:�����������
��
�A

- 	���������: To close a file after file operation

- �����: start a timer

- �����: wait for a timer

:�����������
��
�J

-������: read elapsed time from a started timer

- �����: restart a timer

- $������&��: display an input box at a particular point in the program

:�����������
��
�D

2�$�������&��: display an output box at a particular point in the program.

- 	������!������)�����&��: Opens a com port

- 	������!������"�� : Reads data from a com port

:�����������
��
�'

- 	������!������,����: Writes data to a com port

- 	������!������)����	����: Closes a com port

- �����= call external program
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- ,�����������.���=�waits for an event

- �����.���=�defines an event

2������= Abort Method

:�����������
��
�55

2���������� ���/��(�����= Defines a section with user-defined error handling

2���/���)�������: Starts a bifurcation for programming parallel processes

2��� �)�������: Ends a bifurcation for programming parallel processes

For a detailed description of the input dialogs that correspond to these icons, refer to the on-
line help.

B��� $���/���!���������"2�&�!���!����&�

To use instrument-specific steps (e.g. aspirate, dispense, etc.), the method has to be linked
to an existing deck layout first. Use (��	���
�	���� in menu �
	��� to open the following
dialog:

��
����	���
�	�����
���

Click on [...] to browse for the deck layout you wish to write a method for. Select the layout
from the file list and click Open.

If the selected deck layout corresponds to a Microlab STAR, the check box is enabled. Click
OK to link method and deck layout. Keep the “Smart Steps” check box selected. Note that
multiple deck layouts may be linked to one method to enable programming of different
instruments within one method.

Once you have written a method using instrument specific steps, the “[...]“ button vanishes.
Now the deck layout can no longer be separated from the method until all instrument-specific
steps are deleted again.
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SMART steps are powerfull commands for programming the Microlab STAR.  Whereas
single steps (see next chapter) are restricted to single actions like picking up tips, aspiration,
dispense, etc., SMART steps combine many single steps for specific tasks like filling a
microplate starting with tubes, aliquoting of reagent to a complete plate, loading the deck,
etc.  The available SMART steps are:

�!�� 	����� �!�����&������� )���������������
�&�!���� 

Load Deck

Pipette With
Tips

Unload Deck

Define Needle
Wash

Pick up
Needles

Release
Needles

Load carrier on deck

Pipette using disposable tips

Remove carrier from deck

Specify parameters for needle
wash

Pick up Needles from Wash
Station (or Racks)

Release Needles in racks or
wash station (and start wash)

Sequence, carrier
calibration

Pipette mode, volumes asp/disp
control seq, liquid class,  tip
seq, tip handing/replacement,
tip counter

Sequence

Wash sequence, start
with liquid, settings

Needle sequence

Needle sequence

      

Pick up tips

Eject tips

Pick up disposable tips from tip
rack

Eject disposable tips into tip
waste

Tip sequence, tip
counter

none

The method editor allows you to freely combine SMART steps and single steps.

For all SMART steps, the instrument name is to be selected. This is set by default to the
Microlab STAR’s short name and cannot be changed within  the SMART steps. Only in the
case of two or more instruments linked together is a selection necessary.
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The SMART step pipette is a multifunctional command for various kinds of pipetting tasks.
The Pipette Step allows the user, for example

- to copy one plate into another, or

- to transfer from tubes to a plate with variable numbers of samples, or

- to aliquot reagent into a plate,

all within one step without taking explicit care about the instrument’s initialization, single
steps for aspiration and dispense, sequence handling, or loops.  As is the case for all
Microlab STAR  user software components, SMART Steps too make use of sequences.
Therefore, the pipetting task should be reflected within the sequences defined for this step.
For the explanation of sequences we refer to chapter 7.

In this chapter, the general features of the SMART Step are explained; examples can be
found in the chapter „Methods for Microlab STAR“.

Dragging  a SMART step into the method tree opens the SMART Step input dialog:

Let us now walk through the different sections of the SMART Step.
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Standard or aliquoting mode must be selected. For ���� �� �&�&�����/ mode, three different
procedures are possible:

- “Simple“ pipetting for simple aspiration/dispense cycles,

- “Replica“  for cycles of aspirations/dispenses where the liquid from one source is
dispensed into multiple target containers (no aliquoting), e.g., for a “double test“
(tube 1 -> plate position A1, A2, tube 2 -> plate position A3,A4, etc.). The desired multiple
can be chosen (e.g. 2 for a double test).

- “Pooling“ for cycles of multiple aspirations/dispenses where liquid from multiple source
containers is dispensed into one target container (e.g., tube 1, tube 2  -> plate position
A1, tube 3, tube 4 -> plate position A2, etc). Here too, the desired multiple has to be
chosen (e.g., 12 for pools of 12).

For the aliquoting procedure, the choices under pipetting mode are deactivated. Aliquoting
means that one aspiration is followed by multiple dispenses (e.g., tube 1-> plate positions A1
to A12).

The next step is to select the appropriate tip handling:

First, select the tip sequence - where the tips are to be picked up from. The tip type is
automatically retrieved from the sequence. If the tip sequence is used up, it will be
automatically reloaded. If “Reducible by user“ is checked,  the tip sequence can be reduced
on reloading.

��&���� ���/ can be chosen to

- replace tips “after each dispense“ (if multiple dispenses are needed to transfer e.g. 900 µl
with a standard tip of 300 µl),
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- “after each sample“ (multiple dispenses of the same sample are done with the same tip),

- with “one tip set“, or

- without tip handling, “none“. In this case, STAR will have to pick up tips prior to the
pipette step and eject them after pipetting, using single steps.

- Only for replicas (and pooling), the option “after transfered volume“ becomes active. This
allows you to use fresh tips even for multiple aspiration and dispense cycles being
performed with the same sample.

Finally, a ��&�!������ can be specified, which enables the user to start with a set of tips,
partly used in previous runs, at the correct position. To read a tip counter, it can be specified
within the SMART Step load (see that section). A tip counter is specified by a name, e.g.,
„MyFirstStandardTipCounter“. Note that the name has to be placed between quotation
marks.

Within the SMART Step pipette, the current position of the tip sequence will continuously be
stored under the name of the tip counter, if the check box “write tip counter“ is checked. Note
that a tip counter has to be written if it is to be read by the SMART Step load within the next
run.

The next step is to define the .�����I�J for the pipetting process. For the SMART Step
pipette, one volume for all channels has to be defined.

If a volume for “simple transfers“ is specified that exceeds the volume of the tip, multiple
transfers with equally divided volumes will be performed automatically. A residual volume
may be used too. Then the choice is to discard the residual volume back into the aspiration
sequence, or to dispense it into the waste container.

In the case of aliquoting, a pre-aliquot has to be specified, too. This pre-aliquot is dispensed
back into the aspiration sequence.  A redispense height counted from the bottom of the
container has to be given.

Now, the ��&���������� � ��&���� locations used within this step have to be defined.

The sequence of the aspiration and dispense is to be selected from the dropdown fields. In
addition, the user can opt to reload a sequence: if during pipetting a sequence is used up (no
more tubes are present to aspirate from), the system then asks for a new carrier of tubes to
be loaded. If in addition the checkbox “reducible by user“ is checked, then the user has the
option of reducing the newly loaded sequence at runtime. This is especially helpful if the
exact amount of sample tubes varies from run to run (or from tube carrier to tube carrier).
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An important issue is to select the !���������/���4���!�. This is either the aspiration, or the
dispense sequence. As long as both sequences are of the same length, this selection does
not influence the pipetting (if no pipetting error occurs).

��������������
���
���
 �


��������!�
� ��"

But think of the situation, where the aspiration sequence comprises e.g. 8 tubes, and the
dispense sequence is the one of a 96-well plate. What to do now with the 88 remaining
positions within the plate?  If the aspiration sequence is controlling, the dispense sequence is
reduced to the length of the aspiration sequence and the pipetting stops after dispensing into
the first 8 positions of the plate sequence. If the dispense sequence is controlling, the
aspiration sequence will be repeated until it reaches the length of the dispense sequence.
This results in multiple (12 for an 8-channel instrument) transfers from the same 8 tubes to fill
the complete plate. Then the (controlling) dispense sequence is finished and pipetting stops.
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The following table gives an overview of the different situations and examples. L is the length
of the sequence.

The 4 cases are illustrated in the following diagrams:

	�����=���4I0��&J� ��� ��&���� 
������/��������4I��&J

Use:

-Copy 2 plates into 1 (after
another)

-With reloading of Seq(Disp):
Transfer available tubes to as
many plates as needed.

	���� #=� ��4I0��&J� ��� �� �!� � ��
���/��������4I��&J

Use:

-Transfer a variable number (<96)
of  tubes into a 96-well plate (left
partly filled).

	�����=���4I��&J������ �!� 
������/��������4I0��&J

Use:

-Transfers from many tubes to a
plate and stops when plate is
filled.

-With reloading plate sequences:
Automatically fill as many plates
as needed  with liquid from
tubes.

	���� %=� ��4I��&J� ��� ��&���� � ��
���/��������4I0��&J

Use:

-Transfer reagent from a container
(or, e.g., 8 tubes) to a complete
plate.

-Copy tubes repeatedly into plate.

-With reload of aspiration sequence:
Automatically reload tubes until
plate is filled.

-?����@�M�-?�����@

��&�������
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0��&����
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	�����= L(Sasp) > L(Sdisp), Control: ASP

The target sequence is repeated to match the length of the source sequence.

Another example for this case: All Tubes to Plate(s). Reloadable plate sequence to load all
tubes to as many plates as needed.

	�����=�L(Sasp)> L(Sdisp), Control: DISP

Source sequence is cut to match length of target sequence; stops when plate is full (prepare
plate for assay)

	����#= L(Sdisp) > L(Sasp), Control: ASP

Target sequence is cut to match length of source sequence; stops when tubes are processed
(how many samples today?).  If L(Sasp)>96, plate is filled again!

	����%= L(Sdisp) > L(Sasp), Control: DISP

Source 1

Source 2 Target 1 Target 1
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Source sequence is repeated to match length of target sequence; stops, when plate is full
(Distribute Buffer, Reagents...). Also used for aliquoting.

��4���!����� ���/����)�&�����/��� ��)�����/��� �"�&��!�

In these two cases, the aspiration sequence should be selected as controlling.

��4���!����� ���/��������4����)��!� ���

In the case of aliquoting, the (longer) dispense sequence is to be selected as controlling.
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For the aspiration, the check box “aspirate all“ enables aspiration of the residual liquid from a
container (specify a volume larger than the expected residual volume within the container).
On dispense, the dispense mode “surface“ or “jet“ has to be selected. For aspiration and
dispense, the LLD (liquid level detection) settings have to be specified by clicking on the ��0
button:

Within the LLD dialog, capacitance, pressure, or both LLD types may be switched on. A
sensitivity setting is necessary (see table in chapter 2). If LLD is used, a submerge depth has
to be specified, if a fixed height is prefered, the distance counted from container bottom is to
be specified. For the parallel use of both LLD types, a maximum height difference has to be
given, within which both LLDs have to respond.

The next step is to select the appropriate liquid from the dropdown field.

The selection by attributes (tip type, dispense mode) is automatically made, so that only the
liquid name has to be selected.
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Under “� .��!� “, pre-rinsing and liquid following can be specified.

Furthermore, sequence manipulations can be made (separately for aspiration and dispense
sequences). If the sequences which this SMART Step is going to work with have been used
within this method in preceding steps, the sequence counters can be reset using the two
check boxes for initial sequence manipulation. If other steps are following this SMART Step,
the status of the sequence which is passed back can be defined by the radion buttons under
“final sequence manipulation“.

Under !�������������/�, the user may specify a channel pattern manually, as well as the
number of the channel which will be used to calibrate (1536-well) carriers.

The ������������/� dialog allows you to specify an error handling approach:

The choices in case of an error are: abort the method (only abort button on runtime error
dialog); give the choice (in runtime) to abort or to cancel (continue with user-defined error
handling, if programmed, otherwise abort); or use the fixed default error recovery
(recommended) pre-programmed for the SMART Step. In this case two choices can be
made:
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- “Copy pattern” means that in case of an error on aspiration, the corresponding well of the
dispense sequence will be left out (the pattern is kept). If “copy pattern“  is not checked,
the dispense sequence positions will all be pipetted, leaving an unpipetted well at the end
of the sequence.

- “Exclude error positions” means exclude the erroneous positions from aspiration and
dispense sequences. If this option is enabled and an error occurs during an aspirate or
dispense step, the erroneous position will be excluded from the sequence by removing
the corresponding element from the aspirate or dispense sequence. The next  time these
sequences are used, the erroneous well will not be pipetted.

In addition, :��12�:�(�mode can be enabled. If this checkbox is checked, a timeout has to
be specified, after which the error dialog on runtime will automatically close down again to
continue with the selected error handling: Abort, Cancel, or default error recovery.
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Copy Pattern
Checked

Copy Pattern
NOT Checked
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B������� ���"�����&���� D$���� 

This SMART Step is used to automatically load the instrument deck with all labware
necessary for the run. These commands work with autoload and manual load instruments.
For a manual load instrument, the user is requested to load/unload the carriers by hand.

Dragging the ��� �command to the method tree opens up a dialog box:

The procedure for loading the instrument follows logically from our concept of sequences.
Whatever carriers have to be loaded to ensure that the sequence which is used within the
method is available ��

 be loaded. If, for example, a sequence of samples spans 3 tube
carriers, all 3 carriers will be loaded automatically to their locations (tracks) as defined in the
deck layout.
The dialog box has three main buttons.  Their functions are:
- to load all sequences to the deck,
- to add a specific sequence which can be selected from the dropdown field, and
- to remove a selected sequence.
In the case of a tip sequence, the SMART Step gives you the option to read the current
position of a tip counter, which has to be specified. In this example, the tip counter
“MyStandardTips” is read and the current position of the sequence is set to the value of the
tip counter.
In addition, sequences may be reduced on loading (click on “show details”). If a carrier for
1536-well microplates is being loaded, it may be calibrated using the channel selected in the
dropdown field.
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Click on “Error Settings” to define the error handling for this step. This is similar to the error
handling of the SMART Step Pipette.

To �����  the deck, use the SMART Step Unload. It is very similar to the loading step.

Here, all carriers involved in the specified sequences are unloaded from the instrument deck.
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B�����#� ���"�����&������,�����/�
�� ���

For the washing of needles, three SMART Steps are available. The idea is that needles can
be used like disposable tips without bothering about the organization of the three wash
modules of a wash station.
To do this, the ��� ���&�!1��& command
- waits until a wash module is ready,
- picks up needles from a wash station (or from a separate needle rack, which is in fact an

empty tip rack filled with needles: e.g., the lowneedle_l.rck).

Dragging the command to a method tree opens the following dialog:

The sequence requested here is the sequence running over all (three) modules of a wash
station, thus having 24 positions (8 from each module). This sequence has to be generated
using the sequence editor. The SMART Steps automatically take care of handling the
individual wash modules by incrementing the appropriate sequences in the background.
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The needle eject command
- places the needles into the next available wash module, and
- starts the wash process (on request).

For both commands channel patterns can be set manually. The error settings are again
similar to those of the SMART Step pipette.
An additional SMART Step is available to set the wash parameters; see the section on the
wash station.

B�����%� ���"�����&������)�!1��/��&��� �"�������/���&�

Two further SMART steps allow you to pick up tips from a rack and then dispose of them in
the tip waste after use.
Here is the dialog for the “pick up tips” step:

The dialog asks you to specify a tip sequence.  You also have the option of specifying a tip
counter.
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Here is the dialog for the “tip eject” step:

For “channel settings” and “error settings”, see the description of previous SMART steps.

B����� ���/������&�

Now look at the ���
��9�������.  You will find that, for each deck layout or instrument you
selected, there is now an additional bar containing the instrument-specific steps.
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The table on the next two pages gives a brief outline of the available ML-STAR-specific
commands. These instrument-specific single commands  are used in both the Graphical and
the HSL Method Editors.
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	����� �!�� �!�����&������� )���������������
�&�!���� 

Initialize Initializes the instrument Waste destination,
channel

Load Carrier Loads a carrier on the deck Carrier position1, rack
type

Unload Carrier Removes a carrier from the
deck

Carrier position

Tip Pickup Picks up a CO-RE tip or needle Sequence, tip type,
channel

Tip Eject Discards the tip into the tip
waste or the needle into the
wash station or rack

Waste destination,
channel

Aspirate Draws liquid from a container Sequence, volume,
liquid name, channel,
mix settings, LLD

                                               
1 The carrier position gives the track number on the Microlab® STAR deck where the carrier will be
inserted. For microtiter plate carriers which are 6 tracks wide, the carrier position refers to the leftmost
edge of the carrier.
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	����� �!�� �!�����&������� )���������������
�&�!���� 

0��&���� Drops liquid into a container Sequence, volume,
liquid name, channel,
mix settings, LLD

	����������'#+ Measures precise position of a
high-density microtiter plate
before aspirating or dispensing

Carrier position,
channel

��.���
)�������

Moves the pipetting head to an
absolute position, or to one
relative to the current position

Mode, direction, value

����:���
	����� 

Sends a low-level firmware
command to the instrument

Firmware command,
parameter


����������4�� 
��.��

Gets the z position of the last
liquid level detection

������
�� ��
,���

Starts a needle wash module Name of wash module

,��������,��� Waits for the needle wash
module to be ready

Name of wash module
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	����� �!�� �!�����&������� )���������������
�&�!���� 

���
���&�������

Sets the temperature of a TCC Carrier name,
temperature settings


��
���&�������

Retrieves the temperature of a
TCC

Carrier name, bind
return value to get
temperature in °C (see
chapter about binding
return values)


���)���� Picks up a plate from the
defined position

Position of plate to be
located and picked up
by iSWAP

)��!��)���� Sets a plate down in a defined
position

Movement type,
transport mode, plate
sequence, sequence
counting, lid sequence,
complex movement
parameters

��.��)���� Transfers a plate to another
sequence

Move to sequence

�&���
��&&�� Spreads the fingers of iSWAP’s
robotic hand

Transport mode, plate
sequence, sequence
counting, lid sequence

	�����
��&&�� Closes the fingers of iSWAP’s
robotic hand

Transport mode, plate
sequence, sequence
counting, lid sequence
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B�#� ,�����/�������� 

You can now easily write a method by dragging icons from the toolbox on the left and
dropping them into the method window on the right.

������

��
	���

Inserting a new command or double-clicking on an existing command opens the appropriate
dialog to edit the command-specific parameters, for example the �������
�	�command,
used to define and assign variables:

�������
�	������
	
�����
��

B�%� � ����/�������� 

A method can be edited by the usual Windows copy-and-paste techniques. Mark the step or
the block of adjacent steps within the method editor and right-click the method window to
access the cut/copy/paste menu. To insert a step from the buffer, click on the line above
which the step should be inserted, and then paste.
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B�'� 5��������

Within a method, the user may typically wish to define and process variables. The Graphical
Method Editor recognizes three types of variables: integers (numbers), floats (floating point
numbers), and strings (text variables).

Variables can be newly defined within the dialogs, if they occur

• on the left-hand side of an equation (e.g. x=0, or x=t+1), or

• within edit fields that hold only one variable.

If not explicitly requested (as is the case in the “Open file” dialog), the variable types are
identified automatically. For example, f=5 will generate a variable f of type integer.
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B�+� $���/�������(����!�����=�����������"�������(

In addition to the toolbox elements, several low-level standard library functions are available,
such as the mathematical function library. To use such functions, you have to import the
appropriate library.

Open the )������
��dialog (menu �
	����L)������
����):

)������
�����
��

Click the browse button (“...”) to select a library. Use this dialog to import all the libraries you
need, and to remove libraries you no longer need.

This example links to the HSLML_STARLib.hsl library. This library contains some interesting
functions for the Microlab STAR.
Note that if your method uses a library function, the library in question is indicated in the list
of referenced libraries and can't be removed.

You can also write your own library function using the /�)��
	����+��	���(see chapter 9
HSL Method Editor, page 96) and use it like any of the standard libraries.
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Once you close this dialog with OK, the mathematical library functions (for example) are
available under their own bar and can be invoked like standard commands. In this example,
the following functions are linked and now made available within the method:

Additional functions available include the generation of a Microlab AT-like barcode file, the
execution of a Gemini worklist, the formatting of an ML-STAR barcode file, and the deletion
of an ML-STAR barcode file.  Refer to the online help for more information on these
functions.

The libraries available include:

Library             �����
�����$�����	��������

�

HSLArrLib array variables

HSLDevLib devices

HSLDlgLib dialogs

HSLErrLib errors

HSLFilLib files

HSLMthLib mathematical functions

HSLSeqLib sequences

HSLStrLib string variables

HSLTimLib timer

HSLTrcLib trace files

Pressure based aspiration monitoring off

Pressure based aspiration monitoring on

Capacitance based clot detection off

Capacitance based clot detection on (the clot heigth must be specified in the
liquid class)

Measure container volume with n channels (auto-increment 1=yes, 0=no), if
pattern is reduced (e.g. 11000111), all sequence positions are used

Get container volume of ith channel in ml, as measured in previous „Measure
Container Volume“ Step.

Set threshold for pressure based clot detection.
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B�-� ��� ��/���������������&�"������5�����

If an instrument step returns information, it can be bound to a variable by opening the =���
�
	������
�
��dialog (select step of interest and select menu +��	L=�����
	������
�
����). For
example, the get temperature step of the temperature-controlled carrier returns the
temperature and other information:

=�����
	����1�
�
�����
��

These pieces of §information can be stored in a variable for further processing or output. The
dialog generally lists the return values, each with an editable field to define the variable the
return value is to be bound to.

B�B� ,��1��/�:����,��1�����

B�B��� ������������

Frequently, you will want to import and export worklists. The “open file” command of the
Method Editor is designed to enable such file handling. The data source type (format) is
identified from the extension of the worklist’s file name. The editor supports:

Microsoft Excel .xls

Microsoft Access Database .mdb

Text Files .txt, .csv, .tab, .asc

No other extensions are supported.

B�B��� �,��1�����8�� ���/�:������!��������3!��

You can specify a subset of the available data when you first open a Microsoft Excel
workbook. In a workbook file, you can open a single worksheet, a named range anywhere in
the workbook, or an unnamed range in a single worksheet.
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The following table lists the conventions for these settings.

����&����������6�!����
��� ���

��������������������������������������������(���3

Entire worksheet in a
workbook file

Specify the sheet as ��

	���
O, where ��

	���
�is
the name of the worksheet.

��&������=�You must end the worksheet name with a
dollar sign ($).

Named range of cells
in a worksheet or
workbook file

Specify the named range as #��
�����
, where
#��
�����
 is the name you assigned to the range in
Microsoft Excel.

��&������=�You must name the range in Microsoft Excel
before attempting to open it.

Unnamed range of
cells in a single
worksheet in a
workbook file

Specify the sheet you want to open as ��

	���
O and
the range as -���	:


(�����
=)��	:


(�����
. For
example, to access cells A1 through Z256 in a worksheet
called Sales, you would specify Sales$A1:Z256.

����&����������6�!����
:����                         �������������(���3

Entire worksheet in a
workbook file

Specify the sheet as ��

	���
, where ��

	���
�is the
name of the worksheet.

��&������=�You must ��� end the worksheet name with a
dollar sign ($).

����&&�� ���������6�!� �������������������������������������(���3

Append to an �3�����/
worksheet in a
workbook file

Specify the sheet as ��

	���
O, where ��

	���
�is
the name of the worksheet.

��&������=�You must follow the worksheet name with a
dollar sign ($).

Append to a ����(��
�3�����/ worksheet in
a workbook file

Specify the sheet as ��

	���
, where ��

	���
�is the
name of the worksheet.

��&������=�You must ��� follow the worksheet name with
a dollar sign ($).
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B�;� ,�����/����!�2�(&������� ���������+2	���������!���������"

As discussed in chapter 3.2.1, the 16-channel Microlab STAR is intended to be used as a
batch-like processor. This means all 16 channels should aspirate and dispense
simultaneously, to allow maximum parallelization and highest pipetting speed. In this case,
the reduced random access space of a 16-channel Microlab STAR does not cause any
problems.

To achieve a batch-like process, all sequences involved must consist of blocks of at least 8,
or better 16 positions. Sequence positions within a block must have

• the same x-positions, and

• decreasing y-positions from channel 1 (rear-most) to 16 (front-most).

To program a method using single steps

• Select the option “keep pattern” within the “Channel Settings” dialog in all single steps (tip
pick-up, tip eject, aspirate, dispense). Do ��� use the option “all sequence positions”.

•  Even if an error occurs and “Exclude Channel” is selected as an error recovery, the
pattern will be kept.

To program a method using SMART Steps

• Select “Copy Pattern”

• Do ��� select “Exclude Erroneous Positions”.

• If sequences are reloadable (in runtime during the pipette command),  �����!� the option
“reducible by user” to maintain the original block-wise structure of the sequences.
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;� 8�������� �� ����

The HSL method editor gives the user access to the underlying HSL code, offering higher
flexibility for programming methods. Usually this method editor is used only to customize
methods written with the graphical method editor. Of course, a complete method can also be
written using the HSL method editor.

The /�)��
	����+��	�� is a general-purpose text-like editor that can be used to create
methods based on�/�) (/��()�*#��	�������)������
) for any instrument system. It is a
sub-component of the User Software. Parameters for instrument steps are entered using
dialog boxes, and may include variables. The editor makes use of the same instrument-
specific steps as the graphical method editor. It allows methods to be created, saved,
modified and printed.

To use the /�)��
	����+��	��

• Open Windows Explorer

• Go to folder \Program files\Hamilton\Bin

• Create a shortcut to the executable file named HxHSLMetEd.exe on the desktop.

Use the /�)��
	����+��	�� shortcut you have placed on the desktop to start it.  Then use the
#
��menu to create a new method based on an existing deck layout, or open a previously
written method by means of the File->Open menu.

/�)��
	����+��	��
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The /�)��
	����+��	���window is divided into 3 sections:

The ��
�����
�� on the right is a general-purpose text-like editor window containing the
method written in /�). The general syntax used in HSL is the C/C++ notation.
Instrument steps are shown with a gray background. For safety reasons it is not possible to
change or type in these commands directly. Double-clicking an instrument step displays a
step dialog where you can change specific parameters. To see all step parameters in the
�
	����1�
�, use 1�
���

��	
���	� in the 1�
� menu.

The ���������
�����on the left offers various elements that can be used to build the
method, grouped by the following bars:

�������� 	�������

�);����

!���
9���

�������
���
"

Each device defined in the method shows its own instrument bar
containing all the steps the instrument can execute.


������
 Contains the common /�) language elements such as �� 

�
,

���, ����	������

, etc.


�����$�����	��� A set of standard library functions such as mathematical
functions, trace functions, string manipulation functions etc.

������

� Different variable types.

All these elements can be used by dragging them from the appropriate bar and dropping
them into the �
	����1�
�,�or by using the (��
�	�menu. Alternatively, language elements,
library functions and variables (but not instrument steps) can also be typed directly into the
�
	����1�
�.
When an instrument step is inserted, the appropriate step dialog is displayed so you can
define the specific parameters needed.
After writing a method, invoke Syntax Check from the ���
� menu to check your method.

The �#�
�������$ �
�����at the bottom shows the results of the syntax check, if
performed. If any error is listed in this view, double-clicking on it will set the cursor to the
incorrect statement in the �
	����1�
�.

If the HSL method editor is used to edit a method that was written with the graphical method
editor, insert the HSL code only between two adjacent comment lines. Leave the comment
lines and all code in between unchanged. Save your changes and close the HSL method
editor. If this method is reopened with the graphical method editor, your changes will be
visible as a greyed-out, unchangeable HSL code block.
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Run Control enables you to execute your methods.
During execution of a method, the instrument steps are automatically logged and displayed
in the log window as well as written in a trace file with the same name as the relevant layout
file. The Run Screen shows a static view of the deck layout. Because there is an open n:n
relation between methods and deck layouts (see chapter 4), the Run Control may start either
deck layouts (*.lay), or methods (*.hsl). A further alternative is to start linked methods (*.cmt).
The run control may be accessed by the shortcut buttons of deck layout or method editor.

Then, the method of interest is automatically loaded into the Run Control. Alternatively, the
Run Control may be started by double-clicking the “Microlab STAR Run ” shortcut on the
desktop. Then, the method (or the deck layout) of interest must be opened from the run
control by selecting File->Open from the menu.

On opening the method, a dialog box appears for a period of time, informing the user that the
method is being parsed, i.e., analyzed. This procedure may take up to a minute, depending
on the size of the method.

.����������
	���
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After loading and parsing a method you can use the �	��	�button to execute it.

���
	�����
��$�	�����

Each executed instrument step is logged in the log window.

The choices within Run Control are

• To start a method

• To abort a method

• To use single steps (system pausing after each single step)

• To pause a method (to be continued later)

Clicking on the deck layout view of the Microlab STAR within Run Control adds the Tools
menu to the menu list. Here you will find shortcuts to access the configuration and liquid
editor. The configuration editor is used to switch between simulation and instrument mode.
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The Microlab STAR user software allows you to link different methods together prior to
starting the merged or linked run. To do so, open the Deck Layout Editor and select “File-
>Method Linking”. A dialog appears:

Select the first method of interest and click on the buttons to add the method to the list on the
right-hand side. It is recommended to select HSL files (.hsl)  rather than layout files (.lay) or
method files (.med).

Select  File->Save to generate a chained method file (.cmt). Close the dialog by clicking on
exit. Close the deck layout editor. Open the Run Control by double-clicking the shortcut on
the desktop. Open the newly created .cmt file and execute it.
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As mentioned in chapter 2 The Art of Pipetting, page 12, the background parameters for
pipetting are managed using liquid classes. A liquid class is a set of parameters specifying
the aspiration and dispense behavior appropriate for a given liquid (e.g. water, DMSO,.... ). In
all aspirating and dispensing steps, a valid liquid class must be selected.

Standard liquid classes will be supplied along with the User Software (Water, DMSO,
Glycerine, Precinorm). The standard liquid classes cover a wide range of applications, and
you will probably not need to make any changes to the parameter settings.

For special applications, you can define your own liquid class. This custom liquid class can
be used just like the pre-defined classes.

Defining liquid classes independently serves to simplify the steps in the method and allows
the complete set of parameters to be defined once for all pipetting tasks.

To define a custom liquid class, and to display the parameters of the liquid classes defined,
the Liquid Editor should be used.

����� ��� ����/���4�� �0������

To start the Liquid Editor, select "ML_STAR Liquid Editor" from the Tools menu of the Deck
Layout Editor. The Liquid Editor start window is displayed:

)�%����+��	����	��	�������
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Select for example “StandardVolume_Water_DispenseJet”.  Click Edit to open the Liquid
Details window and go to the Liquid Details tab:

)�%�����
	��
��������

The Liquid Details tab has two sections. At the top, the attributes of the liquid class are
shown: Liquid Name, tip type, dispense mode.


���
��
�%�����
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The liquid parameters section on the left specifies the appropriate instrument parameters for
aspirating and dispensing.

Here is what the various parameters mean:

• G���:������H�and�G��3����:������H are volume flows of liquid in µl/s; they correspond to
plunger speeds for aspirating, dispensing and mixing.

• G���������&����.�����H= air for transport is aspirated at the end of the aspirate step and
automatically dispensed again as an extra volume in the first part of the dispense step.

• G���:����.�����H=�blow-out air is taken up first during aspiration, if dispensing will later
be done using the “empty tip” dispense mode. In the dispense step, the entire volume
including blow-out air is dispensed.
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• G�:�&��&�� H�is the speed at which the dispensing head is drawn up out of the liquid.

• G�������/�����H�is the time the dispensing head has to wait in the liquid after
aspiration/dispensing until it begins to withdraw.

• G�.��2��&������.�����H�is a kind of pre-wetting volume: on aspirating e.g. 20µl of liquid,
first more than 20µl is aspirated (20µl+Over Asp. Vol.), so as to pre-wet the tip. Then this
volume is immediately dispensed again (still in the aspirate step).

• G	���������!�����/��H= a parameter for recognizing blood clots, which determines how
high the dispensing head is allowed to travel up out of the liquid if there is a residual
cLLD signal after aspiration.  It is measured in mm from the height of the liquid surface
upwards. If this distance is exceeded, an error message is generated.

• G���&����:�����H=�dispensing speed of the plunger (expressed as a stream of liquid
volume in µl/s), at which the dispensing step terminates abruptly. If “dispense flow rate“ is
equal to “stop flow rate“, the dispense breaks off abruptly after dispensing the volume
without slowing down beforehand. If “Stop flow rate“ is equal to zero, the plunger
movement becomes gradually slower during the dispense until it stops.

• G���&���!1�.�����H= volume which is aspirated again immediately after the dispense
(as part of the dispense step). This volume is aspirated automatically as quickly as
possible.

The next tab defines the correction curve:
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A correction curve has a target volume and a corrected volume. The “target volume“ is the
volume to be dispensed. The “corrected volume“ is the volume (plunger travelling distance x
diameter) that actually needs to be aspirated for this purpose. In aspirate or dispense steps,
the “target volume“ which will actually be dispensed into the vessel must be entered. The
corrected volumes are usually determined gravimetrically. Accordingly, a corrected volume of
105 µl does not mean that 105 µl of liquid will be dispensed.  When the tip is emptied, 100 µl
are dispensed. The correction is mainly due to the properties of the air column above the
liquid.

The definition of liquid classes allows you to pipette any given liquid with high accuracy.
Liquid classes are also available from HAMILTON’s Application Engineering Group for
custom purposes, if you need them.
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To define a custom liquid class, select a pre-defined liquid in the Liquid Editor start window
and click Create. The Copy Liquid window pops up:

:��$�)�%����������

Type in the name of the new custom liquid class and click OK.

Back in the Liquid Editor start window, select your new liquid class and click Edit. Now all the
parameter input fields in the Liquid Details window are active, so you can make whatever
changes you require.
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A liquid is stored in a configuration file (.cfg). Opening the Liquid Editor loads liquids defined
in the standard liquid configuration file (...\Hamilton\Config\ML_STARLiquids.cfg). If other
liquids are needed from another liquid configuration file, they can be imported. Click Import
liquid(s)... in the Liquid Editor start window to display the Import Liquid(s) window:

(����	�)�%���!�"�������

Open the desired liquid configuration file using the Open file... button. Select the required
liquids.  Close the dialog with OK to import all the liquids selected.

In addition, a similar dialog is available for exporting liquid classes to configuration files. This
dialog is accessed by clicking on Export.
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The Microlab AVS is a separate software component that comes with the vacuum box. It has
to be installed separately. For convenience, you may wish to add the vacuum box
permanently to the deck layout.

The following example describes the programming of the Automated Vacuum System. As a
first step to writing the method, a deck layout with an integrated vacuum box has to be
created. Therefore, open the Hamilton Deck Layout Editor window and select “New“ from the
“File“ menu. This window appears:

Select the Microlab STAR instrument and click OK. An “empty“ STAR deck layout will
appear.
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You have now to select the vacuum box under “Add labware..“ from the labware folder
“VacBox“ under “MLStar“ and put it in the right place on the deck (track 31 for first vacuum
box).

To add a filter plate on the conditioning site of the vacuum box, double-click on position 2 of
the vacuum box and select the right filter plate. The same filter plate can be selected for the
elution site of the vacuum box on position 1. On the same STAR deck layout, all required
carriers can be added with the “Add Labware..“ command under the “Edit“ menu. Finally,
select “Save“ from the “File“ menu to save your deck layout with the integrated vacuum box.
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There is also a possibility to permanently change the default STAR deck layout, which might
be helpful sometimes. This can be done by modifying the configuration. To integrate the
vacuum box in the configuration of the ML STAR, you have to do the following: open the
Hamilton Deck Layout Editor window and select “Open“ from the “File“ menu. Then open the
“Config“ folder and change the “Files of type:“ to “Deck Template“.

From the three different available deck layouts select the „ML_STAR2.tpl“ and open it. Select
the vacuum box under „Add labware…“ and put it on the right place on the deck. Select “File“
and click “Save“. Your default Microlab STAR deck layout is now changed. Whenever you
open a new STAR deck layout, the vacuum box will already be placed on the deck.

Close the Hamilton Deck Layout Editor and open the Hamilton Method Editor. Select “New“
under the “File“ menu and save your method with a new name. Click on “Instruments…“
under the “Method“ menu.
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Click on the grey Deck Layout File button associated with your Microlab STAR instrument. A
list of deck layouts will appear. Select the Microlab STAR deck layout you wish to associate
with this method. The Layout window reappears with the selected layout file showing.
Afterwards select the „VacuumBox“ instrument in order to get all the specific vacuum box
commands.
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After clicking „OK“, three new sets of commands are now accessible via command bars in
the lower left of the Hamilton Method Editor window, namely the Microlab STAR-specific
commands „ML_STAR“ and „ML_STAR Smart Steps“ and the vacuum-box-specific
command „VacuumBox“.
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There are three commands associated with running the vacuum box. These are in
alphabetical order and are described below.

Empty waste command:

Empty waste

This command turns on the waste pump inside the vacuum box controller so that the waste
tray in the conditioning chamber can be evacuated. Select the vacuum box to evacuate.
Vacuum box number 1 is the default. The pump duration will need to be determined by trial
and error. Generally, 25 seconds are adequate for emptying a full waste tray (200 ml). If the
waste bottle is full when this command is running, an error dialog box will appear. The user
then can empty the waste bottle and continue the program. Variables can be used for the
vacuum box number and duration of pumping action.
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Move command:

Move

This command moves the carriage from one chamber to the other. Select the chamber over
which the carriage is to be moved. The conditioning chamber is in front and the elution
chamber in rear. If the vacuum box is not yet initialized when it receives its first “Move“
command, it will initialize first and then move the carriage to the desired chamber. If it is
already at the position specified in the “Move“ command, the carriage will not move.

Vacuum command:

Vacuum

This command runs the vacuum pump inside the vacuum box controller. The vacuum box
number and the chamber have to be selected.
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There are three vacuum parameters to be defined:

The vacuum, in inches of mercury (Hg) (1 inch Hg = 33.86 mbar), is dependent upon your
protocol and the limits set by the filter plate manufacturer. The ramp duration is the time
needed to reach the desired vacuum. This value may need to be determined by trial and
error. The vacuum duration is the length of time that the desired vacuum is to be applied.

Variables can be used for Vacuum box number, Ramp duration, Vacuum duration and
Vacuum. The vacuum pump will operate for a time equal to the ramp duration plus the
vacuum duration.

In the event that the desired vacuum is not achieved during the ramp period, an error will
appear during run time. Automatic error recovery is possible by defining recovery options in
the method. If you click the “Error Recovery…“ button in the Vacuum Parameters dialog box,
the “Vacuum Error Recovery“ window appears.

If you select “Invoke user recovery“, which is already selected as default, the operator can
decide what to do at run time. “Ignore and continue“ and “Abort“, which will release the
vacuum, are the other possibilities. After selecting an error recovery option, click OK.
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We now discuss a sample program to illustrate the use of the vacuum box software.

This could be a part of a normal plasmid DNA isolation protocol combined with a PCR setup.
It is very useful to work with parallel processes using the vacuum box. During the vacuum
procedures, the Microlab STAR robot goes on with pipetting and thus saves time.
Accordingly, this section will also explain how to use the parallelism within the Microlab
STAR User SW.  The first step in our program is “initialize”.  Then come the following steps:
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Let’s discuss the individual steps of this method now.

Drag the parallel process icon. A dialog appears to start parallel process No 1. Enter a name
for the parallel process and click OK. The method editor now shows the bifurcation of the
normal and the first parallel process. The STAR SW supports nested parallel processes.

Drag the Move Step of the vacuum box to the first line of the parallel process.

Move the carriage of vacuum box
number 1 to the conditioning site.

     Click OK.

Now set the vacuum parameters:

Apply a vacuum of 5 inches of mercury on
the conditioning site for a total of 40
seconds.

(10 10 seconds ramp duration plus 30
seconds vacuum duration.
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Now empty the waste of the vacuum box:

Empty waste on the conditioning site for
20 seconds

Finally, end the first parallel process:

End of parallel process1 with all the
vacuum box commands

The bifurcation within the method editor ends after this step.

To process a plate, for example, with the pipetting channels of the microlab STAR, add
pipetting steps to the normal process (left side of the bifurcation).
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Most of the instrument’s day-to-day operations will be driven by methods, so it is important
that they are correctly defined and easy to operate. Programmed methods are stored as a
linked set of ASCII files in the Methods sub-directory on the hard disk. They can be opened,
edited and saved either in the text-like HSL Method Editor (9�/�) Method Editor, page 96) or
in the Graphical Method Editor (D�I�������
��
	����+��	��, page 66).

The present chapter takes a “cookbook” approach.  It teaches you how to program a number
of simple methods typically used in laboratories. By following these steps, you will become
familiar with the layout and workings of the software and can then modify the suggested
methods to suit your own particular requirements, or program new methods based loosely on
those suggested. The scope of the complete command language is rather like that of
common higher programming languages. For details, refer to the �����
���������
�
�
��

�����
, as incorporated in the online help.
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All sample methods explained in this manual are available in the “\DemoMethods_MLSTAR“
directory following installation of the Microlab STAR User Software.

�#���	������������� ����	�&(������)��������)�����$���/����"�����&�

The method we are going to describe first “copies” wells, i.e. aspirates liquids from wells on a
plate and dispenses them to the corresponding wells on another plate (A1→A1’ ...
H12→H12’). The transferred volume will be 50 µl. The method name is “OnePlateToPlate“.
The method uses new CO-RE tips for every well.  We start with an empty target plate.

First, an appropriate deck layout has to be created and saved as “OnePlateToPlatePipette”
(.lay). The deck layout for this method is shown in the picture on the next page.
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To create this deck layout, start the Deck Layout Editor by double-clicking on the “Microlab
STAR Edit” shortcut on the desktop.  Select “New” from the “File” menu.  Select “ML_STAR”
as the current instrument, if more than one instrument is installed. Click OK. Now you see the
schematic view of the Microlab STAR deck.

Double-click on one of the tracks. A dialog box appears. Select a standard carrier for
microplates PLT_CAR_L5MD from the ML_Star directory. You may assign a name to the
carrier. Repeat this to place another plate carrier of the same type on to the deck. Now add a
tip carrier TIP_CAR_480 to the deck.

Double-click on one of the sites of the plate carrier. A dialog box appears. Type in “Source”
for the source plate and click “Browse”. Select “nun_96_fl_l.rck” from the “Nunc” directory.
Click OK. Now you have added a 96-well plate from Nunc to the carrier. Repeat this to place
the target plate on the other plate carrier. Type “Target” in the dialog box. Now that this plate
type has been specified within the deck layout, you may select it directly from the “Type”
dropdown field.

Double-click on one of the sites on the tip carrier. A dialog box appears. Leave the name field
blank and click “Browse”. Select “ standardtip_l.rck” from the “ML_Star” directory. Click OK.
Note: In the example on the CD, a second tip rack is added.

Select “Save” from the “File” menu to store the deck layout under the name
“OnePlateToPlatePipette”.
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Click on “Edit Method” to open up the Graphical Method Editor.

From the method editor's "Method" menu, select "Instruments"  to link the deck layout to the
method as described in the chapter “The graphical Method Editor”.  A window pops up:

Choose “OnePlateToPlatePipette.lay” as the deck layout (browse by clicking the “...” button)
and click OK.  Only now are the instrument-specific commands loaded into the method
editor. They can be accessed by clicking on the “ML_STAR SMART Steps” toolbar in the
toolbox window.

You can easily write the method by dragging icons from the toolbox on the left and dropping
them in the method window on the right. The resulting method will look like this:
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First, drag the SMART Step load into the method window:

Click on “Add all sequences” to make sure all carriers are going to be loaded on to the
instrument deck. Click OK. If you want to decide at runtime which or how many of the wells of
the source plate are to be transfered to the target plate, click on “Show Details” and enable
the checkbox “Reducible” for the source sequence:

Click OK again.

For an instrument with autoload option, this command loads the carriers automatically onto
the instrument deck during runtime. For a manual load instrument, this command requests
the user to load the carriers for runtime.
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Now program your pipetting. Drag the SMART Step pipette to the line below the loading step:

Choose “Standard Pipette Procedure” and “Simple” as a pipetting mode, because it’s a
simple transfer from plate to plate. The volume to be transfered is 50 µl, the residual volume
is 0. Select the tip sequence ML_STAR.Tips from the dropdown field. The tip handling
chosen here is to take new tips for each sample (which is for 50 µl and standard tips, the
same as “after each sample”). Now select the aspiration sequence as the controlling
sequence. Even if both sequences have the same length initially, it makes sense to choose
the aspiration sequence as the controlling one. Remember that on loading this sequence the
sequence may be reduced to less than 96 positions. Then, only the current number of wells
is transfered to the target plate. Both aspiration and dispense sequence are set as not
reloadable. The dispense mode is to dispense in a ”jet”, because initially, the target plate is
assumed to be empty. The liquid class used in this example is water.
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On aspiration, you may use capacitance-based LLD.  Click on the LLD button:

Set the settings according to this example. Click OK. On dispense, switch off the LLD and
dispense to a fixed height (2 mm from bottom):

Accept the defaults for the settings under Advanced and for the error settings. Click OK.
Click Finish in the SMART Step dialog. A window appears showing a summary of your
settings. Click OK.
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Finally, drag the SMART Step Unload to the line below the pipette step:

Click on “Add all Sequences” to add all sequences to the unload step. Click OK.

Within the method editor, click File->Save to store your method.

Your first method is ready to go. See the chapter about running the STAR to see how to run
your method.
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The method we are now going to describe does exactly the same as the method
“OnePlateToPlatePipette“ described in section 13.2.  The only difference is that the method
is now written using single steps, to illustrate the difference.  No sample reduction is possible
here.

First, create the deck layout in the same way as described for the method
“OnePlateToPlatePipette”. This time, save it under the name “OnePlateToPlate” (.lay).

Click on Edit Method. Link the deck layout “OnePlateToPlate” (.lay) to your new method, as
described above.
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Only now are the instrument-specific commands loaded into the method editor. They can be
accessed by clicking on the “ML_STAR” toolbar in the toolbox window.

You can easily write the method by dragging icons from the toolbox on the left and dropping
them in the method window on the right. The resulting method will look like this:
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Let’s start to construct this method. Under the “ML_STAR” toolbar, drag “Initialize” to the
main window.  A window pops up:

Click OK to initialize the instrument in the first step. The waste sequence is selected to eject
tips from the channel during initialization. Always use manual sequence counting for
initialization (see below).  Set the “Always initialize” switch to “On”, to make sure the
instrument is being initialized prior to each run.

Throughout all single steps, the channel pattern to be used may be specified manually.
Clicking on “Channel Settings” opens the following dialog:

You may either deselect specific channels manually by clicking on the check boxes, or check
the box “selection as variable”. Then the channel pattern can be defined as a (string) variable
having a 1 for each active and a 0 for each inactive channel, e.g. “11100011”.  Having
deactivated a channel, the question arises whether to pipette all sequence positions with the
remaining channels (select (1) All sequence positions) or to leave out the corresponding
wells (select (2) channel pattern). Click OK to accept the settings.
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Drag “Load Carrier” to the next line in the method. For an instrument with autoload option,
this command loads the carriers automatically onto the instrument deck during runtime. For a
manual load instrument, this command requests the user to load the carriers for runtime.

Specify the name of the carrier to be loaded. The plate barcodes are stored under the default
file name “barcode_1.txt”. The positions on the deck are automatically retrieved from the
deck layout on runtime. Click OK. (Note that the checkbox “barcode trace “ within the
configuration editor must be checked to generate this file).

Repeat the Load Carrier command for the other plate carrier and the tip carrier.

To copy the whole source plate and not just the first 8 wells to the target plate, the tip pick-
up, aspiration, dispense, and tip eject steps have to be performed 12 times. This can be
achieved by a loop. Drag the Loop command to the next line of the method window. The loop
statement consists of two lines, a “begin loop” and an “end loop” statement.  Whatever code
is inserted between these two statements will be looped.
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The loop dialog window looks like this:

A loop can be performed looping over a fixed number of iterations, over an expression
(repeat while the statement in the expression is true), a sequence, or a file (until the end-of-
file is reached). Here, we loop over the source (plate) sequence. This means, that the loop
will continue until all sequence positions (the 96 wells) of the source plate have been used.
Then, the loop will stop. Choose the default “after loop” for the “Reset Sequence” option to
reset the sequence “source” to the initial position (1) after the loop is done. If you pipette later
to the same sequence (“source”), the sequence will then start at the first well again.
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Under the “ml_star” toolbar, drag “TipPickUp” to the position between the two loop
statements.

A dialog box appears. Choose sequence “ml_star.Tips” and sequence counting "Automatic".
Sequence counting “automatic” means that after pick-up takes place from the first eight
sequence (tip) positions, the tip sequence is automatically incremented. Sequence counting
“manually” means that the sequence used in this step will not be incremented automatically;
during the next tip pick-up process, the positions within the tip rack already used will be used
again. Therefore, we select “Automatic” to increment the sequence automatically by the
number of channels used for the tip pick-up. Next time, tip pick-up will start with the next
(unused) 8 positions in the same tip rack. Click OK.
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Now drag Aspirate to the line below the tip pick-up step.  A dialog box appears.

For sequence, choose “ml_star.Source” to aspirate from the source plate. Select "Automatic"
as sequence counting. For volume, enter 50 µl. Select “Aspiration” as the aspiration mode.
Choose “Standard volume tip without filter” for the tip class and “Dispense jet” as dispense
mode. Then choose an item from the “Liquid class” dropdown list. (For questions about these
parameters, refer Chapter 2 of this manual, “The Art of Pipetting”.)  Select "medium" as the
capacitive LLD sensitivity. Type in 1.0 (or 1) as additional submerge depth. Click "Advanced".
A window appears:
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Set “liquid following during aspirate and mix” to “on”, allowing the channel to follow the falling
liquid level during aspiration. You may now enter the settings for mixing.

The “mix position” is the submerge depth used for mixing, moving the tip downwards from
the current z-position.

Click OK to accept the values. Click OK in the aspirate window.

Now drag Dispense to the position below the aspirate command.  A dialog box appears:

Choose “ ml_star.Target” as sequence to dispense to the target plate. Choose sequence
counting “automatic”. Enter 50 µl for the volume again. Select the dispense mode “Jet Mode
Empty Tip”. Select “ off” as the capacitive LLD setting - because the target plate is empty -
and enter 2 mm as “liquid level”, corresponding to a height of 2mm for the dispense,
measured from the container bottom.
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Click “Advanced”. A dialog window appears. The lower part of the dialog is exactly the same
as for the aspiration step (liquid following and mixing settings).

In the upper part, accept the default for using the same liquid class as in the aspiration step.
Click OK to accept the values. Click OK in the dispense window.
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Finally, drag TipEject.  A dialog box appears.

Accept the defaults, and click OK.
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Finally, the carriers have to be unloaded. This is done by the unload command, with the
carrier name as a parameter.

Click OK. Repeat the unloading for all three carriers.

Within this method, some comment lines have been inserted. The dialog is simple:

To enter a new line hold CTRL and press Enter.

Now your method is complete. Exit the method editor by selecting File/Exit from the menu.

Chapter 15 “Running the Microlab STAR” explains how to run a method.
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This method copies tubes, i.e. aspirates liquid from tubes in a carrier and dispenses them to
wells in a microtiter plate. The maximum number of tubes to be processed is 96,
corresponding to a maximum of four 24-tube carriers (1T).

First, create an appropriate deck layout. In this case, it will be “TubesToPlatePipette (.lay)”.

To create this deck layout, start the Deck Layout Editor by double-clicking on the appropriate
icon. Select “New” from the “File” menu. Select “Microlab STAR” as the current instrument
(see method editor description). Click OK. Now you see the schematic view of the Microlab
STAR deck.

Create a deck layout as shown below:
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Double-click on one of the tracks. In the pop-up window you may enter a name standing for
the tube carrier, and click Browse. Select “Car24_cup15x100.rck” as rack type for a carrier
holding 24 tubes of 15 mm diameter and a height of 100 mm from the “ML_Star” directory.
Click OK. The carrier is added to the deck layout. Repeat this procedure three times more for
the other tube carriers. Place them in adjacent positions on the deck. Now you have added
the tube carriers.

Double-click on another track to add a standard plate carrier. A dialog box appears. “Browse”
for the PLT_CAR_L5MD in the ML_Star directory. Click OK to add the carrier. Double-click
on one of the sites of the carrier. Select “Nunc_96_Flat_L.rck” from the “Nunc” directory.
Click OK. Now you have added a 96-well plate to the carrier.

Double-click on another track to add a tip carrier. A dialog box appears. “Browse” for the
TIP_CAR_480 within the ML_Star directory. Click OK. Double-click on one of the sites of the
carrier. Select “ standardtip_l.rck” from the “ML_Star” directory. Click OK. Now you have
added a tip rack to the carrier. Repeat this to add several tip racks to the carrier.

Save your deck layout under the name “TubesToPlatePipette” (.lay).

We will now define sequences which relate all samples on the one hand and all tip racks on
the other hand.
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Under the “Tools” menu select “Sequence Editor”.  The Sequence Editor opens up.
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Zoom in by clicking the (+) button on the tool bar. Rubber-band all four tube carriers with the
left mouse button. You now see the 96 selected wells of the four carriers. The grid window
(on the left) shows the generated sequence of 96 positions holding all tubes.

Select “Save Sequence” from the “Sequence” menu and enter the name “Samples” for your
new sequence. Select “Save” from the “File” menu. Now the sequence linking all samples is
stored with the deck layout. Select “New” from the “sequence” menu. Now create a sequence
linking all tip racks, by rubber-banding the tip racks. Save the sequence under the name
“Tips”. Now create a corresponding sequence for the plate, again by rubber-banding.  Save
this sequence under the name “Plate”. Select “Exit” from the “File” menu, then click “Yes” in
the pop-up window to save the changes to the deck layout. (Technically, sequences are part
of the deck layout).

Select “Save” from the “File” menu within the deck layout editor to save the changes to the
deck layout under the name “TubesToPlatePipette” (.lay).
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Click on the “Edit Method” button to open up the Method Editor.

From the editor's "Method" menu select "Instruments"  to link the method to be written to the
Microlab STAR deck layout  “TubesToPlatePipette.lay“:

Click on Browse (...) to select the deck layout “TubesToPlatePipette”.

You can easily write the method by dragging icons from the toolbox on the left and dropping
them in the method window on the right. Finally, your method should be as displayed in the
next screen:
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The deck is now loaded using the SMART Step load:
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Click on “add all sequences” to load all sequences and corresponding carriers. Select the
Samples sequence to be reducible by clicking on “show details”. Click OK.

Now add the pipetting step, by dragging it to the next line:

Select

- Standard Pipette Procedure,

- Simple Mode

- Tip Sequence: ML_STAR.Tips

- Volume = 50 µl, residual Volume 0

- Tip handling: After each dispense

- Aspiration sequence (ML_STAR.Samples) as controlling sequence

- ML_STAR.Plate as dispense sequence

- Choose “Not Reload” for the Sample Sequence

- Choose “Reload” or Multiple use for the Plate sequence. This is of no influence here,
since the aspiration sequence is controlling and equally long or even shorter (by
reduction on runtime) than the dispense sequence.

- Dispense mode is “Jet”

- Liquid is Water

- LLD settings are capacitance on aspiration (sensitivity low, submerge depth 2 mm) and
fixed height (2 mm) on dispense, as in the example: “PlateToPlatePipette”.
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Click Finish. Check the input on the summary that appears and click OK.

Now drag the SMART Step Unload to the next line:

Click on “add all sequences” to unload the complete deck. Click OK to add the step.

Now your method is ready to use.

What happens if you run this method? Within the loading step, the sample sequence was
chosen to be reducible. This means that, at runtime, the user sees the following dialog,
enabling reduction of the number of samples (from any position):

One may know to reduce the number of samples to 24. The method then copies 24 tubes
(from the first carrier in this case) to the plate and stops. It is also possible to deselect distinct
tubes from the sequence by clicking on the wells. A reset button is available to restore the
original sequence.

An example of how to program this method using single steps is available on the user
software CD.
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In this example, a simple aliquoting procedure is decribed. The method aspirates 280 µl from
a sample tube rack and dispenses the “pre-aliquot” as well as 12 aliquots of 20 µl each into
an empty plate. The last aliquot is ejected with the tip.

Here’s the deck layout:

Place the following labware components on the deck: a tip carrier TIP_CAR_480 with one tip
rack for standard volume tips, a sample tube rack of 24 tubes called “Sample”, and standard
plate carrier PLT_CAR_L5MD with a 96-well flat-bottom microplate (e.g., the Nunc plate)
called “Plate”. Save the deck layout under “Aliquoten” (.lay).

Open the method editor and select "Instruments" from the editor's "Method" menu to link the
method to be written to the given deck layout “Aliquoten.lay”, as described in the previous
examples.

Here’s the method:
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The loading and unloading is very similar to the previous examples and may be skipped (see
note in example “OnePlateToPlatePipette”). Let’s concentrate on the pipetting step. Drag the
SMART Step pipette to the method:

The selections made here are

- Aliquoting procedure

- The pre- and post-aliquots are 20 µl, as well as the volume of the main aliquots

- The post-aliquot is dispensed back to the aspiration sequence

- The tip sequence is ML_STAR.Tips

- The tip handling is change “after each sample”, meaning that all aliquots (even if multiple
repetitions are necessary) are performed with the same tips

- The aspiration sequence is ML_STAR.Samples and reloadable (this has no influence in
this example, because the dispense sequence is controlling and one aspiration is
sufficient to aliquot the whole plate).

- The (controlling) dispense sequence is ML_STAR.Plate and not reloadable

- LLD settings are as in the previous exampes: cLLD on aspiration (sensitivity low) and
fixed height on dispense

- The dispense mode is now “Jet” (can’t be changed)

- The liquid is “Water for Aliquot” .



Microlab® STAR User Manual

Page 142 of 225                                                                                           610766/02

Click OK to accept the settings. Click OK to quit the summary.

Your method is now ready to go.
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Assume you have a source plate, and a photometer reads the optical absorbance of the
wells of the plate. You now want to create a target plate with all the compounds in the source
plate having an absorbance of A>1.0. The ‘cherry picking’ method does exactly this. The
photometric results are retrieved from a file and a sequence of hits (A>1.0) is created ‘on the
fly’ according to the absorbances read. Pipetting then occurs according to this sequence.

This method does not use ‘Load Carrier’ commands. The system therefore expects the
carriers to be loaded manually onto the deck at the defined positions before the run is
started. The method can, however, be easily adapted for automatic loading (with autoload
option) by inserting the ‘Load Carrier’ commands after the ‘Initialize’ command.

For this method we need a database containing the absorbances of the 96 wells of the
source microplate. The database can be an ASCII text file, a Microsoft® Excel file or a
Microsoft® Access database.

In this case, our database is an Microsoft EXCEL file containing three columns: The “LabID”
defining the plate name of the source plate (Source_1 for the first plate and Source_2 for the
second plate), the "PosID" defining the position within the microplate alphanumerically (A1,
A2, ... , H12), and the absorbance or optical density “OD”.  The work list therefore has193
lines, 1 header line and the entries from 2 plates with 96 wells.
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The name of the sheet is „Absorbance“. (Double-click on the text „Sheet1“ within your Excel
file and edit it to „Absorbance“ (see the section on working with Microsoft Excel).

The deck layout looks like this:

For this method, place two plates called “Source_1“ and “Source_2” and two target plates
(here without name) onto the deck. Two tip rack are needed as well. Save the deck layout
under the name ‘HitPick’.
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This method modifies a sequence (the hit sequence) on runtime. The next step is therefore
to generate a sequence “hits” using the sequence editor. The sequence should span some or
all of the wells in the source microplate(s). Start the sequence editor from the deck layout
editor by selecting “Sequence Editor” from the “Tools” menu. Zoom in to view the source
plate. Rubber-band the entire plate so as to add positions to your new sequence.

Save this sequence under the name “Hits”. Create another sequence spanning the two target
plates and call it “Target”. The last sequence to be prepared is the “Tip” sequence holding
both tip racks. Save the changes to the sequence editor on quitting.

Click the Edit Method Button.

From the editor's "Method" menu select "Instruments"  to link the method to be written to the
given deck layout “HitPick.lay”, as described in the previous examples.
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This method uses library functions. To link the libraries to your method, select “Method” and
“Libraries” from the menu. Click on the browse button and link the two libraries “HSLTrcLib”
and “HSLSeqLib” to the method. Click OK.

The functions available within these libraries are used to generate entries into the methods
trace file, whenever a “Hit” is found, and to manipulate sequences in the appropriate way.
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The items of this method in the graphical Method Editor are displayed on the next screen:
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The first step in this method is to request the user to input a threshold value for the
absorption (“threshold”). This threshold – although numeric – is entered as a string. This is
because, in the next step, a valid SQL database selection statement is created.

The dialog title is the text on the blue top bar of the dialog. The variable name is “threshold”,
the text for the prompt is “Enter threshold for hits” (within quotation marks), the variable type
is string, and the default value is “1.0” (within quotation marks). All other input fields are
optional.

Within the next step, a calculation is made with the string variable read from the user input.

The variable “sqlSelect” is also a string.  It is generated by adding the “sql selection
statement” and the threshold value. This statement, if applied to the data set, selects only the
records (lines) having absorbance values A>threshold.
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The syntax of the SQL statement is: "SELECT * FROM [absorbance$] WHERE OD > "

Here “absorbance$” refers to the name of the Excel sheet which is going to be opened
during the next steps.

Now, the sequence “Hits” as generated within the sequence editor is reduced to 0 (all entries
are deleted) using a library function call:

The parameter is the sequence ML_STAR.Hits.
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Next, the file holding the absorbance information is opened. The file format is also defined
within this step. Drag the green “Open File” icon to the method tree:

Select the tab for opening excel files. In the first input field, the file name is requested. Note
that the file type is an Excel file (.xls) where the sheet name (sheet1 if not defined otherwise)
and the $ sign must be added within the quotation marks. Define a file specifier (here the
default: file1), which is just a name for the file used within your method. Data will later be
read from this file, making reference to this file specifier. Select “Open File to Read” as a
mode, since you want to read data from the file. Now define the file format. Here a variable is
assigned to each column of the file. Later, for each reading step, one record (one line) is
read from the file, and the numbers read are assigned to their corresponding variables
automatically.

Now define the file structure. One line in the “column specification” of the file opening dialog
represents one column in your file. Click on the “Add” button to add the next line to the
dialog.

Enter the data as given in the foregoing screen.  A header, a variable and a variable type are
assigned to each column. The maximum column width is 20 for the string variables which are
of interest here.



Microlab® STAR User Manual

Page 150 of 225                                                                                           610766/02

Select the variable “sqlSelect” from the dropdown list as a command string.

Click OK to finish the definition.

A loop is started, looping over the input file (until the file has been read completely):

Within the loop, the first record of the file is read:

Next, using the library function “SeqAdd”, a sequence position is added to the hit
sequence. No if-then is needed here, because the SQL selection string automatically
skips all records with absorption values less than or equal to the value of the
“threshold” variable.

Then, an entry is made into the methods trace file (HitPick.trc) using the library
function “TrcTrace8”, to inform the user.
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This function adds a text of eight variables to the trace file.

After the file has been analyzed and the Hit sequence has been generated, the
loading of the sequences (carriers) to the deck may start.  The load SMART Step
looks like this:
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The pipetting is then performed by the SMART Step pipette. The important sequence
settings are shown in the next screen:

The aspiration sequence (the hits) is controlling here and not reloadable. The target
sequence is not reloadable either. The rest of the settings is very similar to the
previous example “OnePlateToPlatePipette”.

Finally, the unloading takes place in the usual way.

You will find additional examples, involving, for instance, the reading of a comma-
separated file in MTP map format (HitPick_CSV), in your demo methods directory.
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The following method transfers liquid from tubes to a plate using steel needles. The
aspirations and dispenses are done with single steps and for the washing of needles the
SMART Steps are used. A reduction of the number of samples is possible.

The method uses the following deck layout:

A plate and a set of four tube carriers (of 24 tubes is used). Add the standard plate carrier
(PLT_CAR_L5MD). Add a Nunc plate (nun_96_fl_l.rck) and name  it “Plate”. as well as the
tube carriers (car24_cup15x100.rck) as decribed previously. In addition, a wash station is
added to the rightmost position on the deck. Select the carrier for the wash station
“car_wash_1_standardneedle.tml” from the ML_Star directory.

Save the deck layout under the name “TubesToPlateWithNeedles(.lay)”.

Create a sequence holding all tubes called “Samples”, and a second sequence holding all
wash modules and name it “WashStations”, using the sequence editor as described in the
previous examples.

Click on Edit Method and link the deck layout to the method to be written.
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Here’s what the method finally looks like:
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Load the “Plate” and “Samples” sequences. The “Samples” sequence is reducible (check the
checkbox) to allow a runtime reduction of samples.

Drag the SMART Step “Needle Wash Settings” to the next line, accept the default settings
and click OK. Select the sequence ML_STAR.WashStations.

Drag a loop from the general commands.

Loop over the Samples sequence.
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The next step is the “adjust sequences” command. This command is used to automatically
handle a reduction of samples when using single steps.  If, say, only 4 samples are left over
in the last step, “adjust sequences”  ensures that the system will pick up only 4 tips, aspirate
4 samples, and dispenses into 4 plate positions, leaving the other 4 channels unused.

Multiple sequences may be added to the dialog by clicking on the “Add” button and selecting
the sequence from the dropdown field.
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Now, pick up needles using the SMART Step:
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Select the sequence ML_STAR.WashStations holding all individual wash modules.
Click OK.

Aspirate from the “Samples” sequence and dispense into the “Plate” sequence with
the settings as described in the example “TubesToPLate”.

Eject the needles with the SMART Step:

Again, select the sequence ML_STAR.WashStations and check the checkbox “Start
wash”.

The SMART Steps “needle pick up” and “needle eject” will handle the washing within
the alternating three wash modules automatically.

Finally, the carriers may be unloaded.
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The following example gives an idea of the additional functionality of the Microlab
STAR user software.

Create the following deck layout holding a tip carrier TIP_CAR_480 with tip racks (at
least two racks), 3 tube carriers (car32_cup12x75.rck) for 32 tubes and a
temperature-controlled carrier (car_tcc_1.tml) named “TempCarrier” with a standard
nunc plate (nun_96_fl_l.rck), named “plate”.

Save the layout under the name “Example” (do not use a name longer than 20
characters including extension).

Create sequences for all tips (“AllTips”) and for all tubes (“AllTubes”), using the
sequence editor.

Open the method editor and link the deck layout to the method to be written.

Link the following libraries to the method (method->libraries):
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Finally, the method should look like this, following the first step “Initialize” (the display
of method steps continues overleaf):
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Firstly, initialize the system and load all carriers using the single steps:
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Assign the name of the tip counter (MyStandardTips) to be used throughout this method to
the variable ’TipCounterVariable’ (as a string, i.e. within quotation marks) :

Define a user input request for the temperature of the TCC as well as the number of samples
to be transfered.

For every input, a variable name, a text to prompt for the variable (within quotation
marks),  the variable type, and a default value have to be given.  Type in the inputs
as shown in line 8 of the method overview.
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Set the TCC settings according to the following dialog:

The temperature is now set to the variable CTemp, the value of which is to be typed
in by the user at runtime.

Now, the tip counting is specified using functions from the tip counter library. First,
the user will be requested to reset the tip counter (if required):

The “TipCountingEdit “ function opens up a dialog on runtime, showing the tip
sequence and input fields for start and end positions. Setting the start position to 1
will reset the tip counter - then tips have to be reloaded manually. This function has
parameters: the tip sequence, the name of the tip counter (which is stored in

the variable “TipCounterVariable” here), the device context (select the only choice
“ML_STAR” from the dropdown field), and a timeout. This timeout is used to close the
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dialog automatically without user intervention after 7 seconds (in this case) by
defaulting to the current position of  the tip counter.

Just for demonstration, and not part of this method - another step could be to simply
read the tip counter:

The parameters are the tip sequence and the variable, storing the name of the tip
counter.
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Then sample reduction from the user input is done by setting the end position of the
sequence “AllTubes” to the number as input:

The pipetting loop thus loops over the sequence “AllTubes”:

Consequently, the “adjust sequences” step is used to handle sample reduction if less
than the full number of channels are needed:
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Add all the sequences shown in the dialog, and recall the notes in the previous
chapter.

For the pipetting (single) steps, the settings are as in the other examples:

Tip Pick-up: Sequence “AllTips”, counting automatic

Aspiration: Sequence “AllTubes”, counting automatic

Dispense: Sequence “plate”, counting automatic

Then, the current position of the tip sequence is written into the tip counter:
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Now a further possibility will be demonstrated: how to make decisions within the
method.  Suppose a user output is programmed:

The dialog at runtime prompts for the tip carrier to be unloaded and shows a YES
and a NO button. If the user clicks YES, the return value of this dialog will be 6, if he
clicks NO, the return value will be 7. This value is stored to the variable
“OutputReturn”, as specified in the dialog.  The decision is made depending on the
value of this variable.

The if – then construct compares the variable to the fixed value 6 (=YES clicked).
Only then is the code between the if and the end-if statement executed:

This code is the unloading command for the tip carrier.
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Finally, the AT Barcode Filter Program of the Microlab STAR user software is started
by a library function from the HSLML_STAR.lib library. This function generates the
Microlab AT-like barcode file for the specified plate within the c:\barcodes directory:

�#�;�$���/�������,�)�������!�&�������� ���

The following example demonstrates the use of the iSWAP with ML STAR. A set of plates is
pipetted, transfered to a barcode scanner position without opening the robotic hand, and
finally transferred to another carrier.

Note that the iSWAP works on the basis of sequences.  Plates are moved from one
sequence to another. The sequences remain fixed on the deck, but the plates change
sequences. For this to happen, target and source plate position must be of the same labware
type.

For this example, let’s create the following deck layout using PLT-CAR-L5FLEX for the
microplates. Use the “Add Labware“ dialog (right click into the deck, where no labware is
located) to add a plate position directly to the deck in front of an external barcode reader.
Enter the coordinates

(x = -100mm, y=350mm, z=220mm). Click OK.
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Create independent sequences for pipetting steps and transport steps, using the sequence
editor. Both the transport and pipetting sequences span all 3 plates. The first step of the
method is a simple aliquot step to transfer reagent to the plates, located at plate carrier 1
using the SMART Step “Pipette“.
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Then, we loop over the transport sequence “TransportSequencePlate1To“ spanning all
plates on the left-hand plate carrier. At the beginning of the method, the plates are located on
this plate carrier. In step 3 we pick up the plate from the current sequence position of
sequence “TransportSequencePlate1To“:

The “Movement Type“gives 2 options: either to pick up the plate from a carrier, which is a
simple motion, or to pick up a plate from a reader, etc., which is a complex motion. For a
complex motion additional inputs can be made, such as the “retract distance“ and the “lift-up
height“ (see online help).

“Transport mode“ specifies whether the plate is to be picked up - with or without a lid - or just
the lid itself.
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Sequence counting again determines whether the iSWAP returns to the same or to the next
plate of the given sequence next time.

Note that a plate lid by itself has a sequence with 2 positions. Selecting the transport mode
“Plate with Lid“ will increment the plate as well as the lid sequence.

Under “Advanced“, additional settings may be chosen:

“Grip force“ determines the force that is used to grip the plate. The tolerance gives a
bandwidth in mm for the closing mechanism of the robotic hand in which the plate must be
gripped (torque sensor of iSWAP responds). The grip height is the distance that iSWAP
moves down from the plate’s upper rim to grip the plate. Inverse grip instructs the robotic
hand to pick up a plate with the opposite orientation of the iSWAP (this is not always
possible).

The plate is now moved to the position of the barcode scanner (the position of the sequence
“PlateAtExternalBCScanner“), without opening the hand:

The final step places the plate on the right-hand plate carrier:
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To load the Microlab STAR, first load the carriers with the appropriate labware.

.1) If you have incorporated Q��� 	������R commands into your method, you can start the
run and the instrument will prompt you to load the carriers manually onto the deck. Make
sure the carriers are inserted completely, until they lock into the rear connectors. A magnetic
detector checks whether your loading of carriers is correct.

.2) If you have ���Q��� 	������R commands incorporated into your method, you must load
the carriers manually into the positions on the deck defined in the deck layout ������ the run
is started. Make sure that the carriers are inserted completely, until they touch the rear
connectors.
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Magnetic Sensor



Microlab® STAR User Manual

Page 170 of 225                                                                                           610766/02

	�
�����

When using the Autoload option, first load the carriers with the appropriate labware.

.1) If you have incorporated Q��� 	������R commands into your method: start the “Run
Screen” as described in the following sections, and run the method. The correct positions for
the insertion of carriers will be highlighted by the green LEDs. Insert the carriers into the
tracks of the Autoload tray until they touch the holding pins on the far side of the tray.

Click “Load” in the dialog, and the carriers are loaded onto the deck automatically by the
“load carrier” command in the method. At the same time, the barcodes of carriers and
labware are read and stored in a file.

Alternatively, load the carriers on to the defined positions of the autoload tray before starting
the method. Loading and barcode reading will then be performed without user input.

.2) To repeat what we said already: if you have no ‘LoadCarrier’ commands incorporated into
your method, you must load the carriers manually into the positions on the deck defined in
the deck layout before the run is started. Make sure that the carriers are inserted completely,
until they touch the rear connectors.
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Holder for Carrier
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To run the method “OnePlateToPlatePipette” from the example section, you need to access
the run control. Double-click the “Microlab STAR Run” short cut on the desk top:

From the File menu of Run Control, select Open, and open the deck layout that was created
for the method “OnePlateToPlatePipette” (directory ...\methods\DemoMethods_MLStar).
Your method is now loaded:
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The relevant deck layout appears in the frame in the upper half of the window.  The lower
half contains the Start button and another blank frame which will display the run method log
(method trace file) as it generates.
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Press the Start button to run the method.  You will see that the steps in the method are
traced to the log frame. A loading dialog appears, requesting a reduction of the number of
positions on the source plate, as well as a start position for the tips to be picked up. Both
pieces of information are optional:

You may enter the number of wells on the source plate for this run, delete wells graphically
from the sequence or accept the default (copy the whole plate).

���������� ����(:

Load the deck with the carriers mentioned in the upper part of the dialog box (the 2 plate
carriers and the tip carrier). Don’t forget to place labware onto the correct positions.

������� ����(:

Whenever the system finds a Load Carrier command in the method, the user is requested to
feed the carrier holding the appropriate labware onto the autoload tray. The correct position
is highlighted by LEDs. Alternatively, all carriers can be placed directly in their correct
positions on the autoload tray.

Click OK in the dialog box to start loading.
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At the end of the method, you are requested to unload the carriers from the deck. The
following dialog box opens:
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Click OK within the dialog. Unload all the carriers manually. The unloading will be checked by
the system.

������� ����(=

Click OK within the dialog. The carriers are unloaded to the autoload tray.
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The method is now finished. Within the method trace file, the method completion information
is visible.

The method trace file is stored under “OnePlateToPlate.trc” within the ...\methods directory.
Each method trace contains the date, the method name, and an index within the file name:

The method traces are not overwritten or appended.
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You may test your method using single steps. It is always possible to execute only the next
single instrument step (like TipPickUp, Aspirate, Dispense, etc.) by using the Single Step
button. After each step, the system will be paused and the pause screen appears.

A method can also be paused, clicking on the Pause button of Run Control:

Paused methods can be resumed and finished (!��!1��������&����� ����/�������&����
���&��/).
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It is now possible (during the pause) to open the front cover of the Microlab STAR.  Before
continuing the method, make sure the cover is closed again. You now can continue or abort
method execution.

To abort the method, click abort. You will be prompted to confirm the abort.
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It is also possible to run a simulation instead of the instrument. It is recommended always to
simulate a newly created method first, before running it on the instrument. The run simulation
is switched on in the configuration editor. Access the configuration editor from the run control
by clicking on the deck layout frame. Only now is the Tools menu visible. Select configuration
editor.

Set the switch to simulation.
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On loading commands, the simulator responds for each carrier to be loaded (and unloaded)
with the message:

Click Yes to continue.
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Prior to runtime error handling being used, several types of problems causing errors have to
be solved first. Among these are

- Syntax errors when programming in HSL (forgotten “;”)

- Logical errors (tip eject before pick up, asp 10ul, disp 200ul)

- Semantic errors (wrong pipetting pattern)

- Method/deck interaction errors (dispense 100 µl into the first well of a 1536-well MTP)

- Liquid handling/application errors (droplets, foam, unpipetted wells)

- User-related errors (sample tubes not filled completely, wrong deck loading, barcodes
unreadable)

These problems !������be handled by any runtime error handling.

Problems that can be handled in runtime are

- Not enough liquid

- liquid level not found (if it occurs only rarely)

- No tip picked up

- Clot detected

- Barcode unreadable (if it occurs only rarely)

- Execution error (channel no. 1 has an error (e.g., not enough liquid), then channel nos. 2-
8 have an execution error because they have been stopped before completion of the
step)
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We now focus on some important examples. A detailed description is available in the online
help. Click on Error Settings within the single step dialogs of the Microlab STAR-specific
commands.
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In the case of an error, the process may be continued using the error handling procedure. If,
for example, a barcode of a carrier cannot be read, a dialog window opens up:

In this case, there are 3 options to handle the error:

• 	������� Continue without reading barcode again.

• "�&��� Read barcode again.

• ���!� ���� Enter barcode by hand.

A green dot stands for a tube where the barcode is read correctly.

A red dot stands for a tube where the barcode has not been read correctly.

An orange dot stands for a position with no tube (not detected by the sensor).

After assigning a recovery option, the Execute button is activated and the selected option is
displayed in the lower part of the window. Clicking on Execute causes the instrument to
proceed.

If an error occurs while using pipetting channels, the displayed error dialog shows, for every
single channel, its error state and its recovery options. (Different channels can have different
errors.)
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For example, in case of an LLD error such as no liquid in the container while aspirating, a
window similar to the following pops up:

Red-coloured channel 1 and channel 2 failed to aspirate. To each of these two channels a
recovery option has to be assigned. Only if all channels have the same error is the chosen
recovery option assigned to all channels simultaneously.

Selecting channel 1 shows the error description and the available recovery options for this
channel (buttons Exclude, Repeat, etc.). Invoke one of these options by clicking the
appropriate button. Your selection is displayed in the lower part of the window.

In this case, there are 5 options to handle the error:

• �3!�� � The channel is excluded (no more aspirate, dispense, etc. with this
channel) until next TipPickUp.

• "�&��� Repeat aspirate command.

• ������ Aspirate from bottom of container, without LLD.

• ��� Aspirate air.

• ��.��$& Channel is moved up to dispense liquid into the container. After this action,
aspiration can be repeated.

Note that the Continue button is disabled. This prevents any later dispense with insufficient
volume.

Repeat the same procedure for channel 2. Note that the error and the associated recovery
options may differ from those for channel 1.

When the last channel is processed, the Execute button becomes active and the system can
proceed.

In any case the method can be aborted without further recovery options.
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The user may define a walk-away error handling which uses predefined default settings for
different error situations. These settings can be customized for single steps only. For SMART
steps, the default error recovery is fixed.

For every instrument-specific single step of your method, an individual error recovery can be
defined. You can configure

- the appearance of the error recovery dialogs (which buttons are available)

- the default procedure

- which error is flagged in the trace file

- a timeout, after which the default recovery is carried out (the dialog automatically closes
down).

For this purpose, every instrument-specific single step has a “Error Settings” button. For the
aspiration step, it looks like this:

Among these various tabs, we have selected “Liquid Level Error”. The default settings are
activated.
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To customize the settings, disable the “Use Default” checkbox. A brief description of the error
is given, followed by the available recovery options. Only one default procedure can be
selected. Among the choices are:

- Cancel (quits the current step and starts the user defined error handling, if specified. If no
user defined error handling is present, the method aborts).

- Abort (aborts the method).

- Bottom

- Exclude

- Repeat

- Air

The flag “visible” allows you to add the appropriate button to the error recovery dialog box.
The flag “flag” allows you to flag the error to the trace file.
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To enable walk-away handling of errors, disable the checkbox “infinite” and enter a timeout
into the input field. The runtime error dialog then pops up, waits for the timeout, and closes to
continue with the default error recovery chosen for this error.

If the user clicks on the error dialog during the timeout, the walk away will be stopped, and
the user has to select a recovery and continue manually.

For a list of all errors and their recovery options, refer to the online help and the error settings
dialogs. However, the most important errors are the ones listed in the foregoing chapter.
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Along with the software comes a filter tool to generate a Microlab AT-like barcode file. This
filter can be started manually, or from the shell command of a method (see example). The
sample tracking works as follows:

- Check the check box “sample tracking” in the configuration editor.

- At runtime, one Access-based data base (*.mdb) will be generated within the ...\logfiles
directory, storing all liquid transfers of  one method.

- An additional register file HxRunIndex.mdb stores information about all runs performed.

- After the method (or at least the liquid transfers) are finished, the filter tool can be called
to generate the Microlab AT-like barcode file from the data base. The filter tool is stored
under ...\hamilton\bin.
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Given that a method has been run with the sample tracking enabled and a 96-well plate has
been prepared, the directory c:\barcodes now contains (at least) one barcode file
(At_barco.nij) plus the two register files, containing information about all runs performed so
far (for a description of *.reg files refer to the Microlab AT user manual):

The barcode files can be directly used to couple the Microlab STAR and Microlab FAME.

Now, start the filter tool manually, by selecting

START->Programs->Hamilton->Micolab STAR->AT Barcode Filter

Click on the icon:    
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A window opens up showing the available runs:

Select a run in the upper half to get a list of labware, processed during the run. Double-click
on the plate for which a barcode file is to be generated. Another window opens up, displaying
a table with the pipetting information of the plate in a convenient form:

The table may be printed from the menu.

To start the AT Filter automatically at the end of a method, see the example in chapter 13.7.
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If your labware is not pre-defined, you can define custom racks and containers using the
labware editor. Such custom labware can be used like any other pre-defined labware object
from the library. The idea is that the labware object is a description of the real physical
labware.

To start the Labware editor from the deck editor:

1. select ’Add Labware’ from the ’Edit’ menu or from the popup menu and click the ’Lab.
Editor’ button, or

2. select the Labware Editor from the ’Tool’ menu, or

3. simply click on the ’Define Labware’ icon under on the tool bar.

If you want to add the new labware directly after definition, choose the first procedure.

Whatever you choose, the labware editor starts with the following main window:
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Rectangular racks are specialized grids for holding either tips or containers in row and
column order. A microtiter plate is a rack in this sense, and the wells represent the
containers. The rack is therefore a template describing a discrete number of positions for
holding containers or tips. Examples of racks include a tube rack, a microtiter plate, a
microtiter strip, a deep-well plate, and a tip rack.

The filename has the extension “.rck”.
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Containers are vessels holding liquids (e.g., the wells of a microtiter plate). Containers are
usually placed within racks. Containers may be placed directly onto the carriers, which is the
case e.g. with reagent containers.

The filename has the extension “.ctr”.
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Circular racks are specialized grids for holding either CO-RE tips or containers in a segment
of a circle.

The filename has the extension “.crk”.

�-�#� �3��&��=�0������/���"�!���/�����"�!1�:����	���������

The following sections illustrate the procedures for defining labware using the example of a
rectangular custom rack and containers.

�-�#��� 0������/���	��������

Let’s define a new container. At the end of the container definition we can use that container
in a rack definition.

To start:

1. from the labware editor select 'New' and then 'Container' out of the 'File' menu, or

2. in the Rack definition dialog press the 'New' button.
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In both cases the following dialog box is shown:

We define the containers as round-bottomed tubes of diameter 10 mm, with a total length of
75 mm. Indicate the number of container segments (here 2, because our tube has a
cylindrical and a round-bottomed part) and the clearance height (here 80 mm) at which the
pipetting arm can pass over the container without touching it, as measured from the
container base. The maximum pipetting height counted from the container bottom is 4 mm,
because we want to allow the tip to go down to a position of 4 mm above the tube bottom
(this gives the “dead” volume).

The touch-off height means the position of the tip when dispensing with “touch off” into an
empty container. It is set to 0.3 mm although this option is not available for all instruments
(including the ML-STAR) at the present time. The same is true for the “wick side of container”
checkbox, which in principle enables or disables touch-off at the sides of the containers but is
also not available for all instruments.

The next important option is the “Liquid Level Valid” checkbox, which is activated here, and
the value of 75 mm above the tube bottom to start the liquid level detection within the tube.

The 'Thickness of Container base' is used to place a rack filled with such containers in the
correct Z position.
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When the values are selected, click “Next” to open the next dialog box for segment definition:

Select “cylinder” as a shape for the upper segment and fill in the values for the inner
diameter (10 mm) and the segment height (70 mm).



Microlab® STAR User Manual

Page 188 of 225                                                                                           610766/02

Click on the “Segment 2” tab.

Select “Round base segment” and fill in the value for the upper inner diameter (10mm) and
the segment height (5 mm). Click “Finish” to finish the container definition. You are prompted
for a name for the newly defined container, e.g. choose “MyContainer” (.ctr) and click save.

�-�#��� 0������/���"�!���/�����	������"�!1

Now let’s define a rack for the containers.

Ensure all the racks and containers you define have distinct, obvious names for ease of use.
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Select “New” and “Rectangular Rack” from the File menu of the main window. A series of
query dialog windows starts, giving the user the opportunity to design the rack.

Choose always “Rectangular Rack” to define or modify rectangular racks and microplates.
Choosing “microtiter plate” requests only a subset of the information relevant for the ML-
STAR. Click “Next”.

Specify the number of rows (here 2), the number of holes per row (here 4), and the inner
diameter of the hole (here 12 mm) which will later receive the container. Check “Load Rack
with Containers” and give the overall clearance height of the assembly (here 100 mm). Also
check “Include Rack Boundary” to allow the boundaries to be set in the next steps.  Accept
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the default for “Stagger” (an option allowing you to shift the rows with respect to each other)
and click “Next”.

The next dialog appears:

Specify the distance between the holes in a row (here 20 mm) and the distance between the
rows (here 30 mm). Click “Next”.
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Accept the defaults for the indexing of the holes, for alpha-numeric indices ranging from A1
to H12, and click “Next”.

Type in the width and length of the rack (here, e.g. the outline of a microplate) and the rack
boundaries. Click “Next”.
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See section 17.5 for more information on these inputs.

Now the rack definition is finished. Since we checked “Load the Rack with Containers” in the
second screen, we now have to define the containers which will be placed in the holes of the
rack.

We have the choice either to browse the directories for defined containers (extension “.ctr”)
to fill our new rack with, or to define a new container.

We now come to the end of rack definition, with the new container pre-selected.

Accept the defaults and click “Finish” to finish the rack definition.
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You now see your newly defined rack in the Labware Editor:

Choose Save in the File menu to store the new rack under the name “MyRack” (.rck) in the
labware directory. Select Exit from the File menu.

Once you are back in the “Add Labware” or in the "Deck Layout editor" window, you can put
the newly-designed rack on the deck: under Type select “MyRack.rck”, and the new rack is
visible in the “add Labware” Window.

�-�#�#� 0������/���	�������I���&����J

Carriers are also pieces of labware. Carriers have sites to host racks such as microplates.
Let us now define a carrier, preloaded with flat 96 well nunc microplates.
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To define a carrier, open the labware editor and select New->Template. A window pops up:

The width of the carrier is given by

width/mm=“number of tracks” x 22.5 mm/track

In the case of a plate carrier which is 6 tracks wide, the result is 136mm. The length of a
Microlab STAR track is 497 mm. The clearance height for all carriers on the instrument is
136 mm.

Select the “Preloaded” check box to let the carrier be preloaded with the microplates. Select
a colour of your choice. Click Continue.
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Within the next window, the sites hosting the plates have to be defined:

Click on the Add button and double-click the added line.

The drawing on the right illustrates the different coordinates. The values refer to a standard
microplate. Drawing is only of “optical” influence; accept the defaults. For “Snap to site”,
select the lower option for a microplate, because a microplate fits with its bottom on to the
plate carrier (to enable a good electrical coupling for capacitance-based LLD).

The decision whether a plate (or tip rack) fits on to a site of a carrier is made depending on
the width and legnth of the site: all plates that have the same boundary measures (width and
length) can be placed on the site.

Different plate types (96 flat and deep well, 1536 well, etc.) have the same boundary
measures.
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↔ width

origin x

origin y



Microlab® STAR User Manual

Page 196 of 225                                                                                           610766/02

You may add additional sites to the same carrier. Click next. Now, the site can be preloaded:

Click on Browse, to browse for the corresponding labware and click Add, to add the selected
labware to the site. Click Finish. Save the new carrier within the labware editor.

Now open the deck editor and place the carrier onto the deck:

The carrier is now preloaded with a plate on its site.
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Furthermore, a carrier has several properties, such as barcode positions,  which may be
specified. To do so, open your newly defined carrier in the labware editor and select
Edit>Properties. A dialog opens up. Here, we open a standard plate carrier:
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Entries can be added by clicking on Add. The entry names are to be kept; they roughly
explain the property (see chapter 17.4).

Add the entries and click OK to store them along with the carrier.
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Within the labware, some flags and settings (labware properties) are defined to determine
handling of the labware elements. These properties should not be changed by the user. They
are accessible just so that you can have the maximum of decision-making power in particular
situations that call for it.

These properties can be divided up into the following groups:

• Information for the handling of the auto load unit

• Information for the special units like wash carrier, TTC, tips and needle handling, waste,
etc.

• Information to support the reduction of selection during edit time

�-�%��� ����!����

The properties are always combine a key name and a value. The key names are case
sensitive (the distinction between capital and lower case is important).

All values are in integers (no decimal points).

�-�%��� ����������������8�� ���/������������� �$���
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MlStarCarWidthAsT - 1 .. (n) Width of carrier in T

MlStarCarCountOfBCPos - 0 .. (n) Count of carrier barcode position

How many barcodes positions are
expected.

MlStarCarRasterWidth - 0.1 mm Distance middle of barcode position
to middle of next barcode position.

MlStarCarBCOrientation 0 0 or 1 0 = Vertical,

1 = Horizontal barcode read direction.

MlStarCarFirstBCPos - 0.1 mm Distance between rear of carrier to
middle of first barcode position.

MlStarCarBCReadWidth - 0.1 mm Width of barcode read window

MlStarCarIsRecognizable 0 0 or 1 The carrier has a magnetic bar so its
presence can be detected.

1 = TRUE,

0 = FALSE

MlStarCarIsLoadable 0 0 or 1 The carrier can be loaded and
unloaded. (A wash station, for
example, is not loadable)

1 = TRUE,

0 = FALSE
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S�( 0������ "��/� 0��!��&����

MlStarCarIsAutoLoad 0 0 or 1 The carrier can be loaded and
unloaded by the autoload.

1 = TRUE,

0 = FALSE

MlStarCarPosAreRecognizable 0 0 or 1 The presence of the elements loaded
on the carrier is detected. (e.g. the
containers on a sample carrier are
detectable)

1 = TRUE,

0 = FALSE

MlStarCarNoReadBarcode 0 0 or 1 1 = Don’t read barcode,

0 = read barcode

Notes:

• The position of the carrier barcode is not defined in the properties because this position is
fixed.

• The barcode positions are ordered at regular intervals (one measurement for one carrier).

• On a carrier, all barcodes must have the same orientation, except the carrier barcode
(one value for one carrier)

• The barcode read window is the same for all positions on a carrier. One window should
not overlap the next window, otherwise in some cases the barcode cannot be assigned to
the correct position.

• If a carrier is loadable with auto load (MlStarCarIsAutoLoad), the loadable property
(MlStarCarIsLoadable) value must be set too.

• At edit time in the load step, the user can only select carriers (templates) with underlying
carriers having the property “MlStarCarIsAutoLoad”.

• At runtime, if “MlStarCarIsLoadable” and “MlStarCarIsAutoLoad” are not set, no load is
required; the carriers are fixed on deck or already loaded. If “MlStarCarIsLoadable” is set,
a load dialog is shown, and if “MlStarCarIsAutoLoad” is set, loading is executed by the
instrument.

�-�%�#� �����������������&�!����$����

Properties for “calibrate carrier” single command (Carrier 1536):

S�( 0������ "��/� 0��!��&����

MlStarCarCalibrateX - 0.1 mm Distance between left margin of
carrier to middle of measuring hole.

MlStarCarCalibrateY - 0.1 mm Distance between carrier front to
middle of measuring hole.

MlStarCarCalibrateZ - 0.1 mm Distance from deck to carrier top
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Properties for Temperature-Controlled Carrier (TCC):

S�( 0������ "��/� 0��!��&����

MlStarCarIsTemperated 0 0 or 1 The carrier can be temperature-
controlled

1 = TRUE,

0 = FALSE

MlStarCarIncubatorNumber - 1 or 2 Number of temperature incubation
stations 1 or 2
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Properties for tip and needle handling:

S�( 0������ "��/� 0��!��&����

MlStarIsWasteRack 0 0 or 1 Into this rack tips or needles can be
ejected

1 = TRUE,     0 = FALSE

MlStarTipRack 0 0..8 0 = Standard Vol Tip disposable

1 = Standard Vol Tip disposable with
filter

2 = Low Vol Tip disposable

3 = Low Vol Tip disposable with filter

4 = High Vol Tip disposable

5 = High Vol Tip disposable with filter

6 = Low Vol Steel Needle

7 = Standard Vol Steel Needle

8 = High Vol Steel Needle
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Properties for wash station:

S�( 0������ "��/� 0��!��&����

MlStarNeedleWashRack - 6 .. 8 6 = Low Vol Steel Needle,

7 = Standard Vol Steel Needle,

8 = High Vol Steel Needle

MlStarWashStationNumber - 1 .. 3,

4 .. 6

Number of the wash rack

Wash Station 1 Rack 1 .. 3

Wash Station 2 Rack 4 .. 6
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The aspiration and dispense dialogs always use the inner container bottom as a reference
position (fixed height, liquid level = 0). The x,y,z values of the reference well (usually A1 or 1,
labelled red in the move labware dialog) stored in the instrument’s system of coordinates are
shown in the “Move Labware” dialog. To access this dialog, right-click the labware item of
interest in the Deck Layout Editor, and select “Move Labware”.

The rack and the container both have a clearance height – which means that the movement
of the channels is not impeded if they pass above this height. The software automatically
takes the highest clearance height. The maximum pipetting height is counted from the
bottom of the container upwards and determines the dead volume of the container. The LLD
search height is the height at which the speed of the channel is reduced to look for the liquid
surface.

Clearance heights of

rack and container

                             LLD search height

                                           Maximum pipetting height (the channel cannot go any further down)

:
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Regarding the *�&�������, two different cases of rack placement on the deck can be
distinguished in the Microlab Star:

1. A G!��������2���� H���!1 is placed with the container bottom directly on the carrier
(e.g. the microplates on a plate carrier):

                                        Zthick = thickness of container bottom

                                       Zcarrier

                                                            Zdeck = 100mm

The reference position Z0  is marked with the *. Here, the reference height is calculated from

Z0 = Zdeck+Zcarrier+Zthick ,

ignoring all other terms. Zdeck is a fixed quantity, Zthick is defined in the labware, and Zcarrier

is defined in the carrier template definition.

2. A G��!12���� H���!1 is placed with the frame on the instrument deck (e.g., a tube
rack, where Zcarrier = 0, because the tube rack is used directly as a carrier)

The reference position Z0  is marked with the *. Here, the reference height is calculated from

Z0 = Zdeck+Zcarrier+Zbasediff+Zthick .

Again, Zdeck is a fixed quantity, Zthick and Zbasediff are defined in the labware, and Zcarrier is
defined in the carrier definition. Note that here we have one more term in the equation,
compared to the previous case.

Selection between the two types of racks (container-based rack or rack-based rack), and
thus the decision which formula is used to calculate the reference z-height from the labware
data, is done automatically by selecting the hidden grid for the rack. Thus the question arises
how to define the hidden grid for a rack, i.e., how to define which hidden grid or carrier the
rack should snap onto.  For a rack on top of a carrier, this is done by selecting the
appropriate switch  “snap to base” in the carrier definition.

For a tube rack, which is placed  directly on the deck (it snaps directly into the 1 track grid),
the grid of the tracks automatically assumes a rack-based snap-on. When placing a plate
directly on to the deck the user has to input the x,y,z coordinates of the reference well
directly.

*

*

Zdeck = 100mm

Zcarrier

Zthick = thickness of container bottom

Zbasediff = distance from base of rack to base of container
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All examples shown in the following sections are identical to those in the previous sections,
except that they are written using the HSL Method Editor. Therefore, the previously created
deck layouts can be used here as well. Open a deck layout from the graphical method editor
examples section and save it under a different name. We have chosen the same file names
as those for the other sample methods, but with the notation “HSL_“  prefixed to the name.
All these methods are also available from the “\DemoMethods_MLSTAR“ directory.

To link the Deck Layout Editor permanently to the HSL Method Editor, the value of the
registry key
/M+7;)*:�);��:/(#+K�*-����+K.��
��9K(��	���
�	�K�����
������K�
	����+��	��
has to be changed from /9�
	+��to /9/�)�
	+�.

We recommend that you create a shortcut on the desktop to the HSL Method Editor. The
editor is stored under ...\hamilton\bin\HxHSLMetEd.exe.

�B���	������������� ����	�&(������)��������)����

The method we are going to describe copies wells, i.e. aspirates liquids from wells on a plate
and dispenses them to the corresponding wells on another plate (A1→A1’,...,H12→H12’).
The transferred volume will be 50 µl. The method name is “HSL_OnePlateToPlate“.

First, an appropriate deck layout has to be created and saved as “HSL_OnePlateToPlate”
(.lay). The deck layout for this method is shown in the screenshot.
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To create this deck layout start the Deck Layout Editor by double-clicking on the appropriate
icon. Select “Open” from the “File” menu, then select the deck layout from the example in
chapter 13.3: OnePlateToPlate.lay. Save this layout under the name
HSL_OnePlateToPlate.lay. Alternatively, create the new deck layout again by adding
labware.
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Open up the HSL Method Editor and load the “HSL_OnePlateToPlate” HSL file.  Under the
View menu on the menu bar, check “View All Stepdata” so that all the parameters we enter
will be displayed on the screen.

/�)��
	����+��	��

Save the method to be created under the name HSL_OnePlateToPlate.hsl. Type in the first
line of our method

device ml_star("HSL_OnePlateToPlate.lay");

This command loads the Microlab STAR device driver and links the device to a concrete
Microlab STAR deck layout context and the associated instrument.

The steps in the method we are going to write will appear between the curly brackets of the
method skeleton. One HSL program must contain exactly one such method.

We enter a method name by replacing “oneplatetoplateMethod”:

method TransferPlate ( )

As a first step in the method we initialize the Microlab STAR.  Under the sub-menu “ml_star”,
drag Initialize to a line between the brackets {}.  A dialog window appears.  Click “OK” to
accept the default values.  The line in the programming window should now read

ml_star.Initialize (Channel (1..8): oooooooo );

If it reads only “ ml_star.Initialize();” select “View all step data” in the “View” menu. The
parameters of the command are given between the parentheses. Here, all channels are
initialized, the circles giving a graphic representation of the situation.

Now we enter the commands to load carriers onto the deck. If your instrument is equipped
with the Autoload option, the carriers are automatically moved from the autoload tray into
particular positions on the deck. If not, you will be requested to load the instrument manually.

In keeping with the deck layout, we will load three carriers, the first holding the source plate,
the second holding the target plate, and the third holding the tip rack.



Microlab® STAR User Manual

Page 206 of 225                                                                                           610766/02

Under “ml_star”, drag “LoadCarrier” to a line below “ml_star.Initialize();”.  A dialog window
appears.  For the first carrier, enter carrier position “6” and select rack type
“PLT_CAR_L5AC”. Click OK. This selects a carrier (CAR) for 5 deep-well or archive (AC)
plates (PLT) in landscape (L) orientation.

Again double-click or drag “LoadCarrier” to a line below the last “Load Carrier” command.  A
dialog window appears.  For the second carrier, enter rack position “12” (these carriers are
6T wide) and select rack type “PLT_CAR_L5MD”. Click OK. This selects a carrier for 96-well
or 384-well microtiter plates.

Again double-click or drag “LoadCarrier” to a line below the last “Load Carrier” command.  A
dialog window appears.  For the third carrier, enter rack position “18” and select rack type
“TIP_CAR_480” which is a tip carrier. Click OK. In the method frame we see:

ml_star.LoadCarrier ( Position: 6, rack type: PLT_CAR_L5AC);

ml_star.LoadCarrier ( Position: 12, rack type: PLT_CAR_L5MD);

ml_star.LoadCarrier ( Position: 18, rack type: TIP_CAR_480);

Now we aspirate from one plate and dispense into another, using new tips.  Under
"language", double-click or drag “while” to a line below the last “load carrier” command.
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In the method frame appears

while()

{

}

Position the cursor between the parentheses () and double-click “sequence” under “variable”
in the command frame. In the dialog box select “ ml_star.Source” on the left and
“GetCurrentPosition()” on the right and click OK. This results in:

while (ml_star.Source.GetCurrentPosition ( )  )

Now add by hand the condition “> 0”

while (ml_star.Source.GetCurrentPosition ( ) > 0 )

This means “as long as the position of the source well is greater than zero (or the operation
is not finished), do the following”. When the position reads zero, the sequence has been
worked through completely.

Now we enter the pipetting commands between the curly brackets.

Under the submenu “ml_star”, double-click or drag the single steps. Now double-click or drag
tip pick up.  The same dialog box as in the graphical method editor appears.
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Choose the same settings as in the example with the graphical method editor. The same is
true for the following aspiration, dispense, and tip eject steps.

We should now see the following lines in the programming window:

ml_star.TipPickUp (Channel (1..8): oooooooo , Sequence: ml_star.Tip , 
Tip type: StandardVolumeTip);

This command picks up standard tips without filter on all used channels from the sequence of
the tip rack, i.e. from the tip rack.

ml_star.Aspirate (Channel (1..8): oooooooo , Sequence: ml_star.Source,

         Liquid name: StandardVolume_Water_DispenseJet,  Volume:  50 µl,

       LLD settings: Capacitive: on - Pressure: off, Liquid following: on );

This command aspirates liquid on all used channels from the sequence of the source plate,
i.e. from the source plate. The liquid name specified enables the software to use the
appropriate parameters. Volume and the settings for liquid level detection are further
parameters. Here we aspirate following at liquid level.

ml_star.Dispense (Channel (1..8): oooooooo , Sequence: ml_star.Target,

       Liquid name: StandardVolume_Water_DispenseJet,  Volume:  50 µl,

       LLD settings: off, Liquid following: on);

This command dispenses the given volume into the sequence “ml_star.Target”, i.e. into the
target plate. The liquid name has to be the same as for the aspiration. Here, we dispense
into an empty plate, therefore LLD is switched off and we dispense in a jet, following from 2
mm above the plate bottom.
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ml_star.TipEject (Channel (1..8): oooooooo , Waste destination: 
ml_star.Waste);

This command ejects the tips to the sequence of the waste container “ml_star.Waste”, i.e.
into the waste container.

We now need to get the program to keep count of the wells in the sequences, adding one to
the total so far each time a well is copied.  Create the following lines below the
“ml_star.TipEject” command but above the closing bracket “}”. Under "variables" double-click
"sequence" and select “ml_star.Source” and "Operator++" in the right frame. Click OK.
Repeat this for the other sequences until you have written

ml_star.Source++;

ml_star.Target++;

ml_star.Tip++;

This tells the system to keep adding to the count of source plate wells, to the count of target
plate wells, and to the count of tips.  When 96 wells and tips have been counted, the counter
will go back to zero, thus ending the program in accordance with the “while” statement we
invoked at the beginning. The “++” command automatically adds to the sequence counters
the number of pipettings done so far.

The last lines in the method frame you should see are

}

return;

}

The first bracket “}” finishes the loop of the “while” statement, “return;”, and the last bracket
“}” ends the method “TransferPlate”.
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Finally, your method should look like this:

Now save your work by selecting Save from the File menu. The Software prompts you to
perform a syntax check. Click YES. The result of the syntax check is displayed in the bottom
frame of the method editor. If you have typed in the commands correctly, the result should be
“0 error(s)”.

Another example is available within your demo methods directory: “copy from tubes to
plates”.
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Detailed positional setting for the hardware

��������
��
�
�	�	��

Commercial pipetting tip

�
�%��	

Aliquots are identical small volumes of liquid.

������	


To draw up liquid into a pipetting device.

��	�
���

Option and hardware assembly that enables automatic loading of the Microlab STAR.  It
consists of a loading head movable in Y direction, which draws the carriers into the Microlab
STAR and can read the barcodes on them.

��	�)����	��$

Hardware unit.  On it the carriers can be placed and held outside the Microlab STAR.  The
loading tray is attached to the Microlab STAR, to support the automatic loading and
unloading  process.

=�����
�����

The barcode mask defines the basic structure of a barcode. It is a pattern to which a barcode
must conform. The assignment of a specific labware item can be done this way.  The
barcode mask can require a barcode to contain specific strings at fixed positions. It can
contain wildcards, too.

=�����
��
��
�

Part of the Autoload Option.

=����������
�������

Basic parts of the Microlab STAR with pipetting arm and deck, to which the loading unit and
the options can be added on.
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:����
�

Manipulable unit for loading on the Microlab STAR.  Hardware unit, in or on which elements
stand, and which is transported when the Microlab STAR is loaded (cf. ��	�
���).

:��	���
�

Includes test tubes, reagent containers, and wells.

:��	���
����
�	�����	���

Barcode for identification of containers.  Serves for unambiguous identification of the vessel,
e.g. a sample test tube.

:��	�������
������

Refers to the loading of manipulable elements onto the Microlab STAR after processing has
been started.

-���	���������������
�:��
�

Covering for the Microlab STAR.  Option and assembly with which the work surface of the
Microlab STAR is covered in such a way that it is shielded from user intervention and other
outside influences (such as dust).  At the same time, it protects the user from the movements
of the Microlab STAR.  It is transparent.

�
��

The work surface of the Microlab STAR.  It presents at the same time the greatest possible
area, cf. �������
�.  The placing of the carriers on it is defined by the 55 tracks, as long as
they are in the operating range of the pipetting area.

����
��


To distribute quantities of liquid from a pipetting device.

-������


Programs (sequences of commands) which are carried out on the processors of the Microlab
STAR.

/������
�
����

Type of error which depends exclusively on faulty functioning of the hardware.

(��	���
�	

Hardware of the Microlab STAR (mechanics, electronics, and firmware)
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(��	���
�	���������

The commands made available by the firmware for controlling the Microlab STAR.

)�����


Refers to movable items to be placed on the Microlab STAR deck, such as carriers,
containers, or racks.

)(��

Higher-level data processing system, generally known as Laboratory Information
Management System, also LMS.

)�%���

Includes all kinds of liquids, among which are included reagents, controls, standards, wash
fluids.

))��!)�%����)
�

��
	
�	���"

Positive pipetting of liquid which may be achieved either by pressure, or capacitive signal
detection and transfer.

)������&���
������

The process by which carriers are brought on to the work surface of the Microlab STAR and
taken off again.  This can happen automatically by means of the Autoload Option, or
manually.

�
	���

The method contains all instructions as to how the content of the source vessels is to be
processed.  The assignment of the vessels happens "virtually", however; they are positioned
in the deck layout definition.

�)��������
�����	���


Software running Microlab STAR.

��.�!�����	�	
���
�	
"

In general we assume a plate with 96 Wells (8 x 12)  9 mm wide.

There are also plates with 384 Wells (16 x 24 / 4.5 mm), or others with a different size.

.���


Interruption of processing.  The current processing steps are ended.
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.��
		���

Transfer of liquids, usually a defined number of aliquots, from one container to another.

.��
		�������

Assembly consisting of at least 8 Pipetting channels, as well as the common X-driving and
arm casing.

.��
		���������



Hardware part of the Pipetting arm, which can be moved horizontally in the Y direction.

.��
		��������



Firmware (-processor-program) which controls a pipetting channel, in which category are
included the Y and Z pipetting movement, and the LLD.

.��
���

Pipetting of different liquids in one well:

1,2,3 .... to n, and n to 1,2,3,....

.���
�������	
�

Defines what, where, and with what has to happen on the Microlab STAR.  It is defined in
accordance with the methods, the loading, and the tasks.  These are the foundation stones
of Microlab STAR methods.

����

Grouping of containers in a mechanical, manipulable unit.

�������
�	�����	���

Barcode for Rack identification.

����������
��

Means that every channel can access everywhere on the work area.

���

Execution of the processing steps defined in the relevant method with the aim of processing
one or more liquids and containers (e.g. MTP).  The run is a series of timed commands, in
order to carry out processing on the Microlab STAR according to the processing plan.  The
run can be interrupted to load more elements.  Then processing goes on according to a
newly calculated processing plan, with the run being started again.  Loading is not a part of
the run.
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��������	

Cancellation of a run by the user or by the Microlab STAR.

����1����
���	���

Visualization of the present work status of the Microlab STAR.

����



Refers to a liquid in an unambiguously identified container which is to be processed.

�	���
�

Storage unit for racks

���

Disposable tip for dispensing

��������

Frame that holds the tips together.

�������	


Container into which the tips are dropped.

����� ���

Type of dispensing whereby the tip or needle approaches the bottom of the empty container
so close as to allow the dispensed droplet to have simultaneous contact with the tip or
needle and the container bottom.

����


Note of a status during a processing

���


A narrow container for liquid, usually having a circular cross-section, and a cylindrical length-
section.

��
�

User of the product. Levels of user proficiency are not distinguished by the system.

1
������	����M�	

Option. Aid to check the functions of the Microlab STAR, including adjustment.
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���	
�:��	���
�

A device on the Microlab STAR deck to collect used disposable tips.

�




The individual hollow in the MTP.

�


�	$�


Geometrical shape of the well, such as U, V, or flat.

��������
�������	���
�

Type of dispensing whereby tip or needle touches side of container and thus releases the
droplet.  Not possible with Microlab STAR.

�������
�

The area on the Microlab STAR, to which access is provided during processing.  Elements to
be pipetted can be placed in this area.

����
��	

Information sent from outside the system, as to what method(s) is (are) to be executed on
the Microlab STAR, and with what liquid.
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Access rights  4, 52

Accessories  1, 3, 29, 32

Adding labware  4, 59, 60, 61, 62, 120,
184, 206, 216

Air displacement  3, 14, 25

Aliquot  6, 23, 25, 28, 80, 82, 83, 84, 87,
155, 157, 158, 185, 233

Aspiration  3, 8, 14, 15, 16, 17, 18, 19, 20,
21, 22, 23, 25, 26, 27, 42, 49, 52, 59,
76, 77, 79, 80, 82, 83, 84, 85, 87, 88,
89, 90, 97, 98, 106, 112, 114, 115, 116,
135, 136, 141, 144, 145, 146, 153, 154,
157, 158, 168, 172, 173, 181, 194, 199,
200

Autoload  3, 6, 31, 36, 37, 46, 91, 110,
133, 134, 141, 158, 190, 192, 193, 196,
228, 233, 235

Automated Vacuum System (AVS)  4, 5,
32, 38, 39, 40, 41, 119, 120, 121, 122,
124, 125, 126, 127, 128, 129, 130

Barcodes  6, 9, 31, 32, 36, 53, 55, 103,
141, 184, 187, 190, 197, 198, 203, 204

Batch methods  5, 106

Binding step return values  5, 104

Biohazardous material  11

Carriers  6, 15, 16, 18, 29, 31, 32, 33, 34,
36, 59, 60, 61, 62, 81, 85, 92, 97, 98,
99, 132, 133, 141, 147, 148, 149, 154,
155, 158, 169, 174, 183, 184, 185, 186,
187, 189, 190, 192, 196, 198, 216, 217,
218

Carriers, temperature-controlled  4, 6, 32,
36, 37, 38, 60, 99, 104, 174, 178, 179

Channels (pipetting)  10, 15, 16, 19, 20,
25, 29, 33, 47, 48, 55, 59, 64, 67, 89,
92, 93, 94, 95, 97, 98, 106, 140, 144,
197, 198, 199, 200

Cherry picking  6, 158

Clot detection  3, 27

Collision  59

Configuration (instrument)  4, 29, 31, 52,
53, 54, 55, 56, 71, 110, 117, 118, 121,
141, 175, 195, 196, 200, 203

Configuration Editor  29, 52, 54, 56, 110,
141, 175, 195, 203

Container  6, 10, 11, 14, 15, 16, 19, 20,
21, 23, 29, 34, 36, 40, 55, 59, 64, 67,
83, 84, 88, 97, 98, 145, 147, 199, 207,
209, 211, 212, 215, 234, 237, 238

Contamination and decontamination  3,
11, 15, 20

Control PC  42

Deck  4, 9, 15, 28, 29, 30, 33, 34, 36, 37,
38, 41, 42, 46, 49, 50, 51, 53, 54, 55,
57, 58, 59, 60, 62, 63, 64, 65, 66, 67,
68, 76, 79, 80, 81, 91, 92, 95, 97, 107,
109, 110, 111, 112, 119, 120, 121, 122,
131, 132, 133, 134, 138, 141, 148, 149,
151, 152, 154, 155, 158, 159, 160, 167,
169, 174, 184, 189, 190, 191, 192, 193,
195, 197, 206, 216, 227, 234

Deck layout  30, 33, 42, 49, 50, 51, 54, 57,
58, 59, 60, 64, 67, 68, 76, 79, 80, 91,
95, 107, 109, 110, 111, 119, 120, 121,
122, 131, 132, 133, 138, 141, 148, 149,
151, 152, 155, 159, 160, 169, 174, 184,
189, 190, 191, 195

Dispensing  3, 8, 14, 15, 18, 19, 20, 21,
22, 23, 25, 42, 48, 49, 52, 76, 79, 80,
82, 83, 84, 85, 87, 88, 89, 90, 98, 106,
112, 114, 115, 116, 135, 136, 141, 144,
145, 146, 153, 154, 157, 158, 173, 181,
194, 197, 199, 209

Disposables  3, 33

Disposal (of instrument)  4, 46

Errors  6, 22, 27, 55, 79, 80, 85, 89, 90,
92, 94, 95, 103, 106, 108, 115, 124,
126, 136, 147, 197, 198, 199, 200, 201,
202

File structure  4, 53

Firmware  4, 11, 42, 98

Fuses  43, 45
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Graphical Method Editor  5, 52, 76, 101,
107, 108, 131, 133

Gripper (robotic hand)  99

HSL Method Editor  5, 7, 51, 52, 53, 76,
96, 102, 107, 108, 111, 131, 197

Initialization  82, 97, 99, 125, 127, 140,
158, 175, 177

Installation  4, 42

iSWAP (internal Swivel-Arm Platehandler)
4, 6, 38, 41, 99, 184, 187

Labware  4, 6, 16, 18, 28, 33, 50, 51, 53,
57, 59, 60, 61, 62, 63, 64, 65, 66, 67,
68, 69, 70, 71, 91, 120, 121, 149, 155,
184, 189, 190, 192, 204, 206, 207, 208,
216, 217, 235

Labware Editor  6, 206, 216

Libraries  5, 53, 62, 101, 102, 103, 108,
161, 164, 166, 167, 174, 179, 184, 206

Life cycle (of instrument)  46

Liquid Classes  3, 5, 9, 20, 21, 22, 23, 25,
27, 52, 81, 112, 114, 116, 117, 118,
135, 144, 146

Liquid Editor  5, 21, 52, 112, 113, 116, 117

Liquid level detection (LLD)  9, 10, 15, 16,
17, 18, 22, 23, 27, 88, 97, 98, 136, 144,
145, 154, 158, 199, 209, 218

Liquids  3, 5, 8, 9, 10, 11, 12, 14, 15, 16,
17, 18, 19, 20, 21, 22, 23, 25, 27, 35,
36, 37, 40, 47, 48, 52, 55, 67, 81, 83,
88, 89, 97, 98, 110, 112, 113, 114, 115,
116, 117, 118, 135, 144, 145, 146, 148,
153, 158, 169, 197, 199, 201, 203, 209

Loading and unloading  6, 28, 31, 37, 38,
59, 80, 91, 92, 110, 133, 135, 147, 154,
157, 158, 167, 168, 183, 189, 190, 192,
193, 196, 197

Maintenance  4, 10, 11, 46

Method linking  5, 111

Methods  5, 6, 7, 9, 26, 38, 41, 42, 48, 49,
50, 51, 52, 53, 54, 56, 57, 59, 66, 67,
76, 77, 78, 79, 80, 81, 82, 89, 91, 93,
96, 99, 100, 101, 102, 103, 104, 106,
107, 108, 109, 110, 111, 112, 119, 121,
122, 123, 126, 128, 130, 131, 132, 133,
134, 137, 138, 139, 140, 141, 147, 148,
152, 154, 155, 157, 158, 159, 160, 161,

162, 163, 165, 169, 170, 174, 175, 177,
178, 180, 183, 185, 186, 189, 190, 191,
192, 193, 194, 195, 197, 200, 201, 203,
205

Microtiter plates (MTP)  10, 12, 18, 28, 29,
31, 33, 34, 59, 67, 80, 98, 148, 155,
158, 160, 168, 197, 206, 207, 212, 214,
218

Options  1, 3, 29

Pause  29, 110, 194, 195

Pipetting  3, 6, 14, 20, 21, 29, 30, 47, 67,
81, 82, 84, 85, 87, 92, 94, 106, 112,
116, 135, 137, 141, 142, 144, 152, 153,
155, 157, 158, 168, 185, 236

Plate handling  6, 184

Position  19, 36, 37, 41, 51, 55, 60, 61, 63,
64, 65, 67, 68, 69, 70, 71, 78, 83, 84,
90, 91, 97, 98, 99, 120, 125, 142, 143,
144, 145, 147, 154, 158, 166, 167, 169,
172, 179, 180, 181, 184, 186, 187, 192,
198, 209

Power (electrical)  4, 42, 43, 45

Probe  5, 51, 64, 65, 67, 71

Rack  6, 15, 55, 63, 65, 67, 72, 93, 94, 97,
143, 149, 155, 206, 207, 208, 209, 211,
212, 214, 215, 216, 236, 237

Run  5, 6, 10, 15, 29, 42, 49, 50, 51, 52,
54, 57, 67, 76, 84, 85, 91, 109, 110,
111, 126, 137, 140, 148, 154, 158, 189,
190, 191, 192, 194, 195, 196, 203, 204

Run abort  10, 56, 79, 89, 90, 110, 126,
195, 201

Safety  3, 9, 11

Sequence Editor  4, 67, 149, 150, 160

Sequences  4, 6, 50, 51, 55, 57, 67, 68,
69, 70, 71, 72, 73, 74, 78, 81, 82, 83,
84, 85, 86, 87, 89, 90, 91, 93, 95, 97,
98, 99, 106, 131, 134, 135, 140, 141,
142, 143, 144, 145, 147, 149, 150, 151,
153, 154, 155, 157, 158, 160, 164, 166,
167, 168, 169, 170, 171, 172, 173, 174,
179, 180, 181, 184, 185, 186, 187, 192

Single steps  5, 6, 80, 81, 82, 84, 90, 95,
106, 110, 138, 139, 140, 155, 169, 172,
177, 194, 200
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SMART steps  5, 6, 37, 79, 80, 81, 82, 93,
94, 95, 106, 123, 131, 133, 148, 155,
158, 169, 173, 200

Software  1, 4, 8, 11, 13, 21, 29, 30, 36,
38, 41, 42, 46, 49, 50, 51, 52, 54, 59,
64, 77, 82, 107, 111, 112, 119, 127,
131, 155, 174, 184, 203

Sorting  5, 68, 69, 70, 71, 72, 74

Specifications (technical)  4, 47

Teaching box  55

Teaching mode  4, 55, 64, 65

Tip counter  6, 53, 174

Tip eject  3, 20, 95, 106, 141, 197

Tip pick-up  81, 84, 94, 106, 141, 143, 144

Tip rack  15, 29, 59, 60, 61, 81, 93, 132,
143, 149, 151, 155, 159, 160, 174, 207,
218

Tips, disposable  3, 6, 9, 10, 11, 14, 15,
16, 17, 18, 19, 20, 21, 22, 23, 25, 26,
27, 29, 30, 33, 35, 47, 48, 53, 55, 59,
60, 61, 62, 65, 80, 81, 82, 83, 84, 88,
91, 93, 94, 95, 97, 106, 114, 115, 116,
131, 132, 135, 140, 141, 143, 144, 145,
147, 149, 151, 153, 155, 157, 159, 160,

172, 174, 178, 179, 180, 181, 183, 192,
197, 206, 207, 209, 218

Tolerance  187

Track  4, 55, 59, 60, 62, 64, 120, 149, 216,
217

Training  4, 46

Tubes  6, 9, 10, 12, 15, 16, 18, 28, 29, 30,
31, 32, 33, 55, 59, 60, 62, 80, 82, 83,
85, 86, 87, 91, 148, 149, 151, 154, 155,
169, 174, 197, 198, 207, 209, 216

Variables  5, 15, 18, 76, 78, 82, 100, 101,
103, 104, 107, 108, 124, 126, 140, 163,
165, 166, 167, 178, 179, 180, 183

Verification  4, 46, 47

Walk-away  90, 200, 202

Wash station  15, 20, 32, 34, 35, 36, 42,
45, 81, 93, 94, 97, 98, 169

Waste station  10, 11, 20, 29, 34, 36, 38,
40, 55, 59, 64, 81, 84, 94, 97, 124, 130,
140, 147

Well  8, 18, 47, 55, 59, 61, 65, 67, 89, 90,
109, 131, 142, 155, 157, 159, 169, 178,
187, 192, 197, 216, 218

Worklist  5, 103, 104
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CE, CSA and UL conformity are maintained for Microlab STAR.  See the Declaration of
Conformity for the instrument reproduced on the next page.

"� �������������!��I$����� �	��� �J

This equipment has been tested and found to comply with the limits for a Class A digital
device, pursuant to both Part 15 of the FCC Rules and the radio interference regulations of
the Canadian Department of Communications.  These limits are designed to provide
reasonable protection against harmful interference when the equipment is operated in a
commercial environment.  This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the present user manual, may cause
harmful interference to radio communications.  Operation of this equipment in a residential
area is likely to cause harmful interference, in which case the user will be required to correct
the interference at his own expense.

Pursuant to the Canadian Radio Interference Regulations, ICES-001 Notice for Industrial,
Scientific and Medical Radio Frequency Generators, this ISM apparatus meets all
requirements of the Canadian Interference-Causing Equipment Regulations.  Please note
that this requirement is only for generators which operate at over 10,000 Hz.

���5�����0��/�����!�

The Microlab STAR is ��� intended specifically to be used as an “In Vitro Diagnostic Device”.
The following text defines an “In Vitro Diagnostic Device” [from: Directive 98/79/EC of the
European Parliament and of the Council of 1998-10-27 on in vitro diagnostic medical
devices]:

'[...] �����	�� diagnostic medical device' means any medical device which is a reagent,
product, calibrator, control material, kit, instrument, apparatus, equipment, or system,
whether used alone or in combination, intended by the manufacturer to be used �����	�� for
the examination of specimens, including blood and tissue donations, derived from the human
body, solely or principally for the purpose of providing information:

- concerning a physiological or pathological state, or

- concerning a congenital abnormality, or

- to determine the safety and compatibility with potential recipients, or

- to monitor therapeutic measures.

Specimen receptacles are considered to be �����	�� diagnostic medical devices. 'Specimen
receptacles' are those devices, whether vacuum-type or not, specifically intended by their
manufacturers for the primary containment and preservation of specimens derived from the
human body for the purpose of �����	�� diagnostic examination.

Products for general laboratory use are not �����	���diagnostic medical devices unless such
products, in view of their characteristics, are specifically intended by their manufacturer to be
used for in vitro diagnostic examinations; [...]'
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Wir, Hamilton Bonaduz AG,
CH-7402 Bonaduz/Schweiz
bestätigen, dass das
folgende Produkt

La société Hamilton Bonaduz
AG, CH-7402
Bonaduz/Suisse confirme
que l’instrument ci-dessous

Product name

S/N

��!���������"

....

meets the following EC
directives (including all
applicable amendments):

mit den folgenden EG-
Richtlinien (einschliesslich
aller zutreffenden
Aenderungen)
übereinstimmt:

est en conformité avec les
directives CE suivantes (y
compris leurs
amendements, le cas
échéant):

EMC Directive
89/336/EEC

Low Voltage Directive 73/23/EEC

Applied harmonised standards:

Safety EN 61010-1 (1993) + A2 (1995)

EN 60825-1 (1994) + A11 (1996)

Emission

Immunity

EN 61326 (1997) + A1 (1998) class B

EN 61326 (1997) + A1 (1998)

(laboratory equipment)

Additional Information:



C US

Canada, USA
CAN/CSA-C22.2 No. 1010.1-92

UL Std. No. 3101-1

FCC, Part 15, class A
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A current checklist is available from HAMILTON.
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Chemical 1.4310 EPDM FPM PE NBR PEEK POM PP PTFE PVC PVDF SI

Acetic acid, 20% 1 2 3 1 3 1 1 1 1 1 1 2

Acetic acid, glacial 1 4 4 1 4 1 4 1 1 4 1 2

Acetone 1 1 4 2 4 1 1 1 1 0 3 3

Acetonitrile 1 3 3 1 4 0 3 3 1 0 1 0

Ammonium hydroxide,
5% 1 1 2 1 2 1 1 1 1 0 2 1

Chloroform 1 4 3 3 4 1 4 3 1 4 1 4

Deionized water 1 1 1 1 1 1 1 1 1 1 1 1

Dimethyl formamide 1 2 4 1 4 1 1 1 1 4 4 2

Dimethyl sulfoxide 1 3 3 1 4 0 1 1 1 4 3 0

Ethyl acetate 1 3 4 2 4 1 1 1 1 4 3 2

Hexane 1 4 1 3 1 1 1 2 1 4 1 4

Hydrochloric acid, 20% 4 1 1 1 4 1 4 1 1 1 1 3

Isopropyl alcohol 1 1 1 1 3 1 1 1 1 4 1 1

Methanol 1 1 3 1 3 1 1 1 1 3 1 1

Methylene chloride 1 4 3 4 4 2 3 3 1 4 1 4

Nitric acid, 5-10% 1 2 1 1 4 1 4 1 1 1 1 2

Nitric acid,  70% 1 4 2 3 4 1 4 4 1 4 1 4

Phosphate buffer 1 1 1 1 1 0 1 1 1 0 1 4

Phosphoric acid, 85% 2 3 1 1 4 0 4 1 1 1 1 3

Potassium hydroxide
conc. 1 1 4 1 3 1 3 1 1 0 2 3

Sodium acetate 1 1 3 1 3 0 1 1 1 3 1 4

Sodium borate 1 1 1 1 3 0 1 1 1 1 1 1

Sulfuric acid, 1-75% 2 4 1 1 4 2 4 1 1 1 1 3

Urine 1 1 1 1 1 1 1 1 1 1 1 1

Triethylamine 1 4 3 0 3 0 1 4 1 0 3 4

Toluene 1 4 1 3 4 1 1 3 1 4 1 4

����!���IS�(����!� ���������.�������J=

1 = no effect, little or no noticeable change

2 = slight corrosion or discoloration

3 = Moderate corrosion or other change in physikal properties or dimensions; not recommended for
continuous contact

4 = severe corrosion or physical change;prolonged contact not recommended

0 = No data
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1.4310 Steel

EPDM Ethylene-propylene-elastomer

FPM Fluoroelastomer

NBR Acrylnitril-butadiene-rubber

PE Polyethylene

�
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PEEK Polyetheretherketone

POM Polyoxymethylene

PP Polypropylene

PTFE Polytetrafluorethylene

PVC Polyvinylchloride

PVDF Polyvinylidenefluoride

SI Silikon

��� 	����!���!��&��������(������/������������!��:�����������

Chemical 1.4310 EPDM FPM PE PEEK PP PTFE PVDF SI

Acetic acid, 20% 1 2 3 1 1 1 1 1 2

Acetic acid, glacial 1 4 4 1 1 1 1 1 2

Acetone 1 1 4 2 1 1 1 3 3

Acetonitrile 1 3 3 1 0 3 1 1 0

Ammonium hydroxide, 5% 1 1 2 1 1 1 1 2 1

Chloroform 1 4 3 3 1 3 1 1 4

Deionized water 1 1 1 1 1 1 1 1 1

Dimethyl formamide 1 2 4 1 1 1 1 4 2

Dimethyl sulfoxide 1 3 3 1 0 1 1 3 0

Ethyl acetate 1 3 4 2 1 1 1 3 2

Hexane 1 4 1 3 1 2 1 1 4

Hydrochloric acid, 20% 4 1 1 1 1 1 1 1 3

Isopropyl alcohol 1 1 1 1 1 1 1 1 1

Methanol 1 1 3 1 1 1 1 1 1

Methylene chloride 1 4 3 4 2 3 1 1 4

Nitric acid, 5-10% 1 2 1 1 1 1 1 1 2

Nitric acid,  70% 1 4 2 3 1 4 1 1 4

Phosphate buffer 1 1 1 1 0 1 1 1 4

Phosphoric acid, 85% 2 3 1 1 0 1 1 1 3

Potassium hydroxide conc. 1 1 4 1 1 1 1 2 3

Sodium acetate 1 1 3 1 0 1 1 1 4

Sodium borate 1 1 1 1 0 1 1 1 1

Sulfuric acid, 1-75% 2 4 1 1 2 1 1 1 3

Urine 1 1 1 1 1 1 1 1 1

Triethylamine 1 4 3 0 0 4 1 3 4

Toluene 1 4 1 3 1 3 1 1 4
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1 = no effect, little or no noticeable change

2 = slight corrosion or discoloration

3 = moderate corrosion or other change in physical properties or dimensions; not recommended for continuous contact

4 = severe corrosion or physical change; prolonged contact not recommended

0 = No data
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1.4310 Steel

EPDM Ethylene-propylene-elastomer

FPM Fluoroelastomer

PE Polyethylene
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PEEK Polyetheretherketone

PP Polypropylene

PTFE Polytetrafluorethylene

PVDF Polyvinylidenefluoride

SI Silicon


